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A Few Words 

About this Kit
The overall goal of this kit is fun. Beyond this, the aim is to get 

you comfortable using a wide range of electronic components 

through small, simple and easy circuits. The focus is to get 

each circuit working then giving you the tools to figure out why. 

If you encounter any problems, want to ask a question, or would 

like to know more about any part, extra help is only an e-mail away help@oomlout.com.

About Open Source Hardware
All of .:oomlout:.'s projects are open source. What does this mean? It means everything 

involved in making this kit, be it this guide, 3D models, or code is available for free download. 

But it goes further, you're also free to reproduce and modify any of this material, then distribute 

it for yourself. The catch? Quite simple; it is released under a Creative Commons (By - Share 

Alike) license. This means you must credit .:oomlout:. in your design and share your 

developments in a similar manner. Why? We grew up learning and playing with open source 

software and the experience was good fun, we think it would be lovely if a similar experience 

was possible with physical things.

(more details on the Creative Commons CC (By - Share Alike) License can be found at )

( http://tinyurl.com/2dkzmd )

About .: oomlout :.
We’re a plucky little design company focusing on producing 

“delightfully fun open source products”
To check out what we are up to

http://www.oomlout.com

About Problems
We strive to deliver the highest level of quality in each and every thing we produce. If you ever 

find an ambiguous instruction, a missing piece, or would just like to ask a question, we’ll try our 

best to help out. You can reach us at:

help@oomlout.com
(we like hearing about problems it helps us improve future versions)

Thanks For Choosing .:oomlout:.
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Step 5: Plug In Your Arduino
Plug your Arduino in:

using the included USB cable, plug your Arduino board into a 
free USB port

0302

01 ASEM
assembling the 

pieces

Breadboard
x1

Arduino
x1

3mm x 10mm bolt
x2

3mm nut
x4

Arduino Holder
x1

02 INST
installing 

(software and hardware)

.: NOTE: :.
.: Encountering problems? :.

.: Would like more details? Using Linux? :.
.:http://tinyurl.com/r99d8u :.

Step 1: Download the software
Goto 

http://arduino.cc/en/Main/Software
And download the software for your operating system

Windows XP Mac OSX

Step 2: Unzip the Software
Unzip

arduino-00 -win.zip (
Recommended Path

c:\Program Files\

rr rr- version #)

Step 3: Shortcut Icon
Open

c:\program files\arduino-00  (

Right Click

Arduino.exe (send to>Desktop (create shortcut) )

rr\ rr- version #)

Step 4: Plug In Your Arduino
Plug your Arduino in:

using the included USB cable, plug your Arduino board into a 
free USB port

Wait for a box to pop up

Step 5: Add new Hardware
Skip searching the internet

(click the next box when prompted to do so)

Install from a Specific destination
(click “Install from a list or specific location (Advanced))

Choose the Location
c:\program files\arduino-00rr\drivers\FTDI USB Drivers\

Finished

Step 2: Unzip the Software
Unzip (double click)

arduino-00 -mac.zip (
Move Folder

move /arduino-00

rr rr- version #)

rr/ to //Applications/

Step 3: Alias Icons
Open

//Applications/arduino-00  (

Command Click
Make Alias

Drag to Desktop

rr/ rr- version #)

Step 4: Install Drivers
Goto

//Applications/Arduino-00

FTDIUSBSerialDriver_V2_2_9_Intel.dmg 
(V2_1_9.dmg if not an Intel Mac) 

Restart

rr/drivers/
Double Click & Install

.: Putting It Together :.
.: Installing the IDE :.

This is the program used to write programs for the Arduino (meta?). 
It may seem a little daunting at first but once you have it installed 

and start playing around, its secrets will reveal themselves

.: For an introduction to what an Arduino is visit :.
.: http://tinyurl.com/9txjmh :.
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// (single line comment)

It is often useful to write notes 

to yourself as you go along 

about what each line of code 

does. To do this type two back 

slashes and everything until the 

end of the line will be ignored by 

your program.

{ } (curly brackets)

Used to define when a block of 

code starts and ends (used in 

functions as well as loops)
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Arduino Programming in Brief
 The Arduino is programmed in the C language. This is a quick little primer targeted at people 

who have a little bit of programing experience and just need a briefing on the ideosyncrocies of 

C and the Arduino IDE. If you find the concepts a bit daunting, don't worry, you can start going 

through the circuits and pick up most of it along the way. For a more in depth intro the 

Arduino.cc website is a great resource (the foundations page http://tinyurl.com/954pun)

Structure

void setup(){  }
All the code between the two 

curly brackets will be run once 

when your Arduino program 

first runs.

Each Arduino program 

(often called a sketch) has 

two required functions 

(also called routines).

Variables

void loop(){  }
This function is run after setup 

has finished. After it has run 

once it will be run again, and 

again, until power is removed.

Syntax

; (semicolon)

Each line of code must be 

ended with a semicolon (a 

missing semicolon is often the 

reason for a programme 

refusing to compile)

One of the slightly 

frustrating elements of C is 

its formating requirements 

(this also makes it very 

powerful). If you remember 

the following you should be 

alright. 

/*  */(multi line comment)

If you have a lot to say you can 

span several lines as a 

comment. Everything between 

these two symbols will be 

ignored in your program.

A program is nothing more 

than instructions to move 

numbers around in an 

intelligent way. Variables are 

used to do the moving

long (long)
 Used when an integer is not 

large enough. Takes 4 bytes 

(32 bits) of RAM and has a  

range between -2,147,483,648  

and 2,147,483,648. 

int (integer)
The main workhorse, stores a 

number in 2 bytes (16 bits). 

Has no decimal places and will 

store a value between -32,768 

and 32,768.

boolean (boolean)
A simple True or False variable. 

Useful because it only uses one 

bit of RAM.

char (character)
Stores one character using the 

ASCII code (ie 'A' = 65). Uses 

one byte (8 bits) of RAM. The 

Arduino handles strings as an 

array of char’s

float (float)
 Used for floating point math 

(decimals). Takes 4 bytes (32 

bits) of RAM and has a range 

between -3.4028235E+38 and  

3.4028235E+38. 

Maths Operators
= (assignment)  makes something equal to something else (eg. x = 

10 * 2 (x now equals 20))
% (modulo)  gives the remainder when one number is divided by 

another (ex. 12 % 10 (gives 2))
+   (addition)
- (subtraction)
* (multiplication)
/ (division)

Operators used for 

manipulating numbers. 

(they work like simple 

maths)

Comparison Operators

== (equal to) (eg. 12 == 10 is FALSE or 12 == 12 is TRUE)

!= (not equal to) (eg. 12 != 10 is TRUE or 12 != 12 is FALSE)

< (less than) (eg. 12 < 10 is FALSE or 12 < 12 is FALSE or 12 < 14 is TRUE)

> (greater than) (eg. 12 > 10 is TRUE or 12 > 12 is FALSE or 12 > 14 is 

FALSE)

Operators used for logical 

comparison

Control Structure
if(condition){ }
else if( condition ){ }
else { }

This will execute the code between 

the curly brackets if the condition is 

true, and if not it will test the else 

if condition if that is also false the 

else code will execute.

Programs are reliant on 

controlling what runs 

next, here are the basic 

control elements (there 

are many more online)

for(int i = 0; i < 
#repeats; i++){   }

Used when you would like to 

repeat a chunk of code a number 

of times (can count up i++ or 

down i-- or use any variable)

Digital

digitalWrite(pin, value);

Once a pin is set as an OUTPUT, 

it can be set either HIGH (pulled 

to +5 volts) or LOW (pulled to 

ground).

pinMode(pin, mode);

Used to set a pins mode, pin is 

the pin number you would like 

to address (0-19 (analog 0-5 

are 14-19). the mode can either 

be INPUT or OUTPUT.

int digitalRead(pin); 

Once a pin is set as an INPUT 

you can use this to return 

whether it is HIGH (pulled to 

+5 volts) or LOW (pulled to 

ground).

Analog
int analogWrite(pin, 
                value);
Some of the Arduino's pins support 

pulse width modulation (3, 5, 6, 9, 10, 

11). This turns the pin on and off very 

quickly making it act like an analog 

output. The value is any number 

between 0 (0% duty cycle ~0v) and 255 

(100% duty cycle ~5 volts).

The Arduino is a digital 

machine but it has the ability to 

operate in the analog realm 

(through tricks). Here's how to 

deal with things that aren't 

digital.

int analogRead(pin);

When the analog input pins are set 

to input you can read their voltage. 

A value between 0 (for 0 

volts) and 1024 (for 5 

volts) will be 

returned

.:For a full programming reference visit:.
http://tinyurl.com/882oxm
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DC Motor What it Does: No. of Leads:

Spins when a current is passed through it. 2

Identifying: Things to watch out for:

This one is easy, it looks like a motor. Usually   - Using a transistor or relay that is rated for 

a cylinder with a shaft coming out of one the size of motor you're using.

end More Details on Wikipedia:

  http://tinyurl.com/d826yh

Hobby Servo What it Does: No. of Leads:

Takes a timed pulse and converts it into an 3

angular position of the output shaft. Things to watch out for:

Identifying:   - The plug is not polarized so make sure it 

A plastic box with 3 wires coming out one is plugged in the right way.

side and a shaft with a plastic horn out the More Details:

top.   http://tinyurl.com/4zo4he
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Electronics in Brief
No previous electronic experience is required to have fun with this kit. Here are a few details 

about each component to make identifying, and perhaps understanding them, a bit easier. If at 

any point you are worried about how a component is used or why its not working the internet 

offers a treasure trove of advice, or we can be contacted at help@oomlout.com

Component Details
LED 
(Light Emitting Diode)

What it Does: No. of Leads:

Emits light when a small current is passed 2 (one longer this one connects to positive)

through it. (only in one direction) Things to watch out for:

Identifying:   - Will only work in one direction

Looks like a mini light bulb.   - Requires a current limiting resistor

More Details on Wikipedia:

  http://tinyurl.com/zhpyv

Piezo Element
What it Does: No. of Leads:

A pulse of current will cause it to click a 2

stream of pulses will cause it to emit a tone. Things to watch out for:

Identifying:   - Difficult to misuse. 

In this kit it comes in a little black barrel, but More Details:

sometimes they are just a gold disc.   http://tinyurl.com/38crmu

Potentiometer
What it Does: No. of Leads:

Produces a variable resistance dependant on 3

the angular position of the shaft. Things to watch out for:

Identifying:   - Accidentally buying logarithmic scale.

They can be packaged in many different More Details:

form factors, look for a dial to identify.   http://tinyurl.com/28pbhd

IC (Integrated Circuit)
What it Does: No. of Leads:

Packages any range of complicated 2 - 100s (in this kit there is one with 3 (TMP36) and 

one with 16 (74HC595)electronics inside, an easy to use form factor 
Things to watch out for:Identifying:
  - Proper orientation.(look for marks showing pin 1)The part ID is written on the outside of the 
More Details:package. (this sometimes requires a lot of 
  http://tinyurl.com/87k4dlight or a magnifying glass to read)

Photo Resistor
What it Does: No. of Leads:

Produces a variable resistance dependant on 2

the amount of incident light. Things to watch out for:

Identifying:   - Remember it needs to be in a voltage 

Usually  a little disk with a clear top and a divider before it provides a useful input.

curvy line underneath. More Details:

  http://tinyurl.com/c2wdkw

Component Details (cont.)

Pushbutton What it Does: No. of Leads:

Completes a circuit when it is pressed 4

Identifying: Things to watch out for:

A little square with leads out the bottom and   - these are almost square so can be 

a button on the top. inserted 90 degrees off angle. 

More Details:

  http://tinyurl.com/cmts7d

0 - Black 5 - Green 20% - none
1 - Brown 6 - Blue 10% - silver
2 - Red 7 - Purple 5% - gold
3 - Orange 8 - Grey
4 - Yellow 9 - White

first digit

second digit

# of zeros

tolerance

Examples:
green-blue-brown - 560 ohms
red-red-red - 2 200 ohms (2.2k)
brown-black-orange - 10 000 ohms (10k)

Resistor Color Code Lead Clipping
Some components in this kit come with very long wire 
leads. To make them more compatible with a breadboard 
a couple of changes are required.
LEDs:
Clip the leads so the long lead is ~7mm long and the 
short one is ~5mm 
Resistors:
Bend the leads down so they are 90 degrees to the 
cylinder. Then snip them so they are ~6mm long.
Other Components:
Other components may need clipping 
use your discretion when doing so.

Resistors What it Does: No. of Leads:

Restricts the amount of current that can flow   2 

through a circuit. Things to watch out for:

Identifying:   - Easy to grab the wrong value (double check 

the colors before using)  Cylinder with wires extending from either 
More Details on Wikipedia:end. The resistance value is displayed using 
  http://tinyurl.com/cmeqw5a color coding system (for details see next 

page)

Transistor What it Does: No. of Leads:

Uses a small current to switch or amplify a 3 (Base, Collector, Emitter)

much larger current. Things to watch out for:

Identifying:   - Plugging in the right way round.(also a 

current limiting resistor is often needed on the base pin)  Comes in many different packages but you 
More Details on Wikipedia:can read the part number off the package. 
  http://tinyurl.com/eazkn(2N222A in this kit and find a datasheet online)

Diode What it Does: No. of Leads:

The electronic equivalent of a one way 2 

valve. Allowing current to flow in one Things to watch out for:

direction but not the other.   - Will only work in one direction (current will 

flow if end with the line is connected to ground)Identifying:
More Details on Wikipedia:Usually a cylinder with wires extending from 
  http://tinyurl.com/ysz57beither end. (and an off center line indicating polarity)
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through it. (only in one direction) Things to watch out for:

Identifying:   - Will only work in one direction

Looks like a mini light bulb.   - Requires a current limiting resistor

More Details on Wikipedia:

  http://tinyurl.com/zhpyv

Piezo Element
What it Does: No. of Leads:

A pulse of current will cause it to click a 2

stream of pulses will cause it to emit a tone. Things to watch out for:

Identifying:   - Difficult to misuse. 

In this kit it comes in a little black barrel, but More Details:

sometimes they are just a gold disc.   http://tinyurl.com/38crmu

Potentiometer
What it Does: No. of Leads:

Produces a variable resistance dependant on 3

the angular position of the shaft. Things to watch out for:

Identifying:   - Accidentally buying logarithmic scale.

They can be packaged in many different More Details:

form factors, look for a dial to identify.   http://tinyurl.com/28pbhd

IC (Integrated Circuit)
What it Does: No. of Leads:

Packages any range of complicated 2 - 100s (in this kit there is one with 3 (TMP36) and 

one with 16 (74HC595)electronics inside, an easy to use form factor 
Things to watch out for:Identifying:
  - Proper orientation.(look for marks showing pin 1)The part ID is written on the outside of the 
More Details:package. (this sometimes requires a lot of 
  http://tinyurl.com/87k4dlight or a magnifying glass to read)

Photo Resistor
What it Does: No. of Leads:

Produces a variable resistance dependant on 2

the amount of incident light. Things to watch out for:

Identifying:   - Remember it needs to be in a voltage 

Usually  a little disk with a clear top and a divider before it provides a useful input.

curvy line underneath. More Details:

  http://tinyurl.com/c2wdkw

Component Details (cont.)

Pushbutton What it Does: No. of Leads:

Completes a circuit when it is pressed 4

Identifying: Things to watch out for:

A little square with leads out the bottom and   - these are almost square so can be 

a button on the top. inserted 90 degrees off angle. 

More Details:

  http://tinyurl.com/cmts7d

0 - Black 5 - Green 20% - none
1 - Brown 6 - Blue 10% - silver
2 - Red 7 - Purple 5% - gold
3 - Orange 8 - Grey
4 - Yellow 9 - White

first digit

second digit

# of zeros

tolerance

Examples:
green-blue-brown - 560 ohms
red-red-red - 2 200 ohms (2.2k)
brown-black-orange - 10 000 ohms (10k)

Resistor Color Code Lead Clipping
Some components in this kit come with very long wire 
leads. To make them more compatible with a breadboard 
a couple of changes are required.
LEDs:
Clip the leads so the long lead is ~7mm long and the 
short one is ~5mm 
Resistors:
Bend the leads down so they are 90 degrees to the 
cylinder. Then snip them so they are ~6mm long.
Other Components:
Other components may need clipping 
use your discretion when doing so.

Resistors What it Does: No. of Leads:

Restricts the amount of current that can flow   2 

through a circuit. Things to watch out for:

Identifying:   - Easy to grab the wrong value (double check 

the colors before using)  Cylinder with wires extending from either 
More Details on Wikipedia:end. The resistance value is displayed using 
  http://tinyurl.com/cmeqw5a color coding system (for details see next 

page)

Transistor What it Does: No. of Leads:

Uses a small current to switch or amplify a 3 (Base, Collector, Emitter)

much larger current. Things to watch out for:

Identifying:   - Plugging in the right way round.(also a 

current limiting resistor is often needed on the base pin)  Comes in many different packages but you 
More Details on Wikipedia:can read the part number off the package. 
  http://tinyurl.com/eazkn(2N222A in this kit and find a datasheet online)

Diode What it Does: No. of Leads:

The electronic equivalent of a one way 2 

valve. Allowing current to flow in one Things to watch out for:

direction but not the other.   - Will only work in one direction (current will 

flow if end with the line is connected to ground)Identifying:
More Details on Wikipedia:Usually a cylinder with wires extending from 
  http://tinyurl.com/ysz57beither end. (and an off center line indicating polarity)
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CIRC-01Code (no need to type everything in just)

File > Sketchbook > Examples > Digital > Blink
(example from the great arduino.cc site check it out for other ideas)

/*
 * Blink
 *
 * The basic Arduino example.  Turns an LED on for one second,
 * then off for one second, and so on...  We use pin 13 because,
 * depending on your Arduino board, it has either a built-in LED
 * or a built-in resistor so that you need only an LED.
 *
 * http://www.arduino.cc/en/Tutorial/Blink
 */

int ledPin = 13;                // LED connected to digital pin 13

void setup()                    // run once, when the sketch starts
{
  pinMode(ledPin, OUTPUT);      // sets the digital pin as output
}

void loop()                     // run over and over again
{
  digitalWrite(ledPin, HIGH);   // sets the LED on
  delay(1000);                  // waits for a second
  digitalWrite(ledPin, LOW);    // sets the LED off
  delay(1000);                  // waits for a second

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/cmn5nh

Making it Better

LED Not Lighting Up?

LEDs will only work in one 

direction.
try taking it out and twisting it 

180 degrees.
(no need to worry, installing it 

backwards does no permanent 

harm)

Changing the pin: Control the Brightness:
The LED is connected to pin 13 but we can use any of Along with digital (on/off) control the Arduino can control 

the Arduino’s pins. To change it take the wire plugged some pins in an analog (brightness) fashion. (more details on 

into pin 13 and move it to a pin of your choice (from 0- this in later circuits). To play around with it.

13) (you can also use analog 0-5 analog 0 is 14...) Change the LED to pin 9: (also change the wire)
ledPin = 13; -> int ledPin = 9;

Then in the code change the line:
 int ledPin = 13; -> int ledPin = (newpin); Replace the loop() code with:

Then upload the sketch: (ctrl-u) analogWrite(ledPin, (new number));

Change the Blink Time: (new number) = any number between 0 and 255.
Unhappy with one second on one second off?  0 = off, 255 = on, in between = different brightness

Fading:In the code change the lines:
  digitalWrite(ledPin, HIGH);  We will use another included example program. To open go to.
 delay(time on);  //(seconds * 1000)

File > Sketchbook > Examples > Analog > Fade digitalWrite(ledPin, LOW);
 delay(time off); //(seconds * 1000)

Then upload to your board and watch as the LED fades in and 

then out.

Still No Success?

A broken circuit is no fun, send 

us an e-mail and we will get 

back to you as soon  as we can.

help@oomlout.com
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CIRC-01

What We’re Doing:

.:Getting Started:.

.:(Blinking LED):.

LED’s (light emitting diodes) are used in all sorts of clever 

things which is why we have included them in this kit. We will 

start off with something very simple,  turning one on and off, 

repeatedly, producing a pleasant blinking effect. To get started 

grab the parts listed below, pin the layout sheet to your breadboard and then plug everything in. 

Once the circuit is assembled you'll need to upload the program. To do this plug the Arduino 

board into your USB port. Then select the proper port in Tools > Serial Port > (the comm 

port of your Arduino). Next upload the program by going to File > Upload to I/O Board  

(ctrl+U). Finally bask in the glory and possibility that controlling lights offers.

If you are having trouble uploading, a full trouble shooting guide can be found here: http://tinyurl.com/89s2po

The Circuit:

Wire 
10mm LED

x1

560 Ohm Resistor
Green-Blue-Brown

x1

2 Pin Header

x4

CIRC-01 

Breadboard sheet

x1

Schematic:
Arduino 
pin 13

LED
(light emitting diode)

resistor (560ohm)

(blue-green-brown)

gnd
(ground) (-)

.:download:.
printable 

breadboard overlay
http://tinyurl.com/qukhvc

.

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/cwhx27

The Internet

Parts: Program Not Uploading 

 This happens sometimes, 

the most likely cause is a 

confused serial  port, you 

can change this in 

tools>serial port>
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CIRC-01Code (no need to type everything in just)

File > Sketchbook > Examples > Digital > Blink
(example from the great arduino.cc site check it out for other ideas)

/*
 * Blink
 *
 * The basic Arduino example.  Turns an LED on for one second,
 * then off for one second, and so on...  We use pin 13 because,
 * depending on your Arduino board, it has either a built-in LED
 * or a built-in resistor so that you need only an LED.
 *
 * http://www.arduino.cc/en/Tutorial/Blink
 */

int ledPin = 13;                // LED connected to digital pin 13

void setup()                    // run once, when the sketch starts
{
  pinMode(ledPin, OUTPUT);      // sets the digital pin as output
}

void loop()                     // run over and over again
{
  digitalWrite(ledPin, HIGH);   // sets the LED on
  delay(1000);                  // waits for a second
  digitalWrite(ledPin, LOW);    // sets the LED off
  delay(1000);                  // waits for a second

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/cmn5nh

Making it Better

LED Not Lighting Up?

LEDs will only work in one 

direction.
try taking it out and twisting it 

180 degrees.
(no need to worry, installing it 

backwards does no permanent 

harm)

Changing the pin: Control the Brightness:
The LED is connected to pin 13 but we can use any of Along with digital (on/off) control the Arduino can control 

the Arduino’s pins. To change it take the wire plugged some pins in an analog (brightness) fashion. (more details on 

into pin 13 and move it to a pin of your choice (from 0- this in later circuits). To play around with it.

13) (you can also use analog 0-5 analog 0 is 14...) Change the LED to pin 9: (also change the wire)
ledPin = 13; -> int ledPin = 9;

Then in the code change the line:
 int ledPin = 13; -> int ledPin = (newpin); Replace the loop() code with:

Then upload the sketch: (ctrl-u) analogWrite(ledPin, (new number));

Change the Blink Time: (new number) = any number between 0 and 255.
Unhappy with one second on one second off?  0 = off, 255 = on, in between = different brightness

Fading:In the code change the lines:
  digitalWrite(ledPin, HIGH);  We will use another included example program. To open go to.
 delay(time on);  //(seconds * 1000)

File > Sketchbook > Examples > Analog > Fade digitalWrite(ledPin, LOW);
 delay(time off); //(seconds * 1000)

Then upload to your board and watch as the LED fades in and 

then out.

Still No Success?

A broken circuit is no fun, send 

us an e-mail and we will get 

back to you as soon  as we can.

help@oomlout.com
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CIRC-01

What We’re Doing:

.:Getting Started:.

.:(Blinking LED):.

LED’s (light emitting diodes) are used in all sorts of clever 

things which is why we have included them in this kit. We will 

start off with something very simple,  turning one on and off, 

repeatedly, producing a pleasant blinking effect. To get started 

grab the parts listed below, pin the layout sheet to your breadboard and then plug everything in. 

Once the circuit is assembled you'll need to upload the program. To do this plug the Arduino 

board into your USB port. Then select the proper port in Tools > Serial Port > (the comm 

port of your Arduino). Next upload the program by going to File > Upload to I/O Board  

(ctrl+U). Finally bask in the glory and possibility that controlling lights offers.

If you are having trouble uploading, a full trouble shooting guide can be found here: http://tinyurl.com/89s2po

The Circuit:

Wire 
10mm LED

x1

560 Ohm Resistor
Green-Blue-Brown

x1

2 Pin Header

x4

CIRC-01 

Breadboard sheet

x1

Schematic:
Arduino 
pin 13

LED
(light emitting diode)

resistor (560ohm)

(blue-green-brown)

gnd
(ground) (-)

.:download:.
printable 

breadboard overlay
http://tinyurl.com/qukhvc

.

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/cwhx27

The Internet

Parts: Program Not Uploading 

 This happens sometimes, 

the most likely cause is a 

confused serial  port, you 

can change this in 

tools>serial port>



Operating out of sequence  

With eight wires it's easy to cross 

a couple. Double check that the 

first LED is plugged into pin 2 and 

each pin there after.
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CIRC-02Code (no need to type everything in just)

Download the Code from ( http://tinyurl.com/dkpxbn )
(and then copy the text and paste it into an empty Arduino Sketch)

 
//LED Pin Variables * will then turn them off 
int ledPins[] = {2,3,4,5,6,7,8,9};
              //An array to hold the        void oneAfterAnotherNoLoop(){
              //pin each LED is connected to   int delayTime = 100; 
              //i.e. LED #0 is connected to pin 2            / / t h e   t i m e   ( i n   m i l l i s e c o n d s )   t o   p a u s e                    

     //between LEDs
void setup()   digitalWrite(ledPins[0], HIGH);  //Turns on LED #0 
{                                 //(connected to pin 2)
  for(int i = 0; i < 8; i++){   delay(delayTime);     //waits delayTime milliseconds
     //this is a loop and will repeat eight times   ...
    pinMode(ledPins[i],OUTPUT);   ...
     //we use this to set LED pins to output   digitalWrite(ledPins[7], HIGH);  //Turns on LED #7 
  }                                                                  //(connected to pin 9)
}   delay(delayTime);    //waits delayTime milliseconds  

//Turns Each LED Off
void loop()          // run over and over again   digitalWrite(ledPins[7], LOW);  //Turns off LED #7
{   delay(delayTime);    //waits delayTime milliseconds
  oneAfterAnotherNoLoop();     ...
      //this will turn on each LED one by 
      //one then turn each oneoff -----more code in the downloadable version------        
  //oneAfterAnotherLoop();   
     //this does the same as onAfterAnotherNoLoop
     //but with much less typing
  //oneOnAtATime();          
  //inAndOut();               
}

/*
 * oneAfterAnotherNoLoop() - Will light one then 
 * delay for delayTime then light the next LED it 

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/d2hrud

Making it Better

Some LEDs Fail to Light 

 It is easy to insert an LED 

backwards. Check the LEDs 

that aren't working and ensure 

they the right way around.

Switching to Loops:
in the loop() function there are 4 lines. The last Extra Animations:

Tired of this animation? Then try the other two three all start with a '//' this means the line is 
sample animations. Uncomment their lines and treated as a comment (not run). To switch the 
upload the program to your board and enjoy the new program to use loops change the void loop() 
light animations. (delete the slashes in front of row 3 and then 4)code to:

  //oneAfterAnotherNoLoop();   
  oneAfterAnotherLoop();   
  //oneOnAtATime();          Testing out your own Animations:

Jump into the included code and start changing   //inAndOut();

things. The main point is to turn an LED on use 
Upload the program, and notice that nothing has 

digitalWrite(pinNumber, HIGH); then to turn 
changed. You can take a look at the two 

it off use digitalWrite(pinNumber, LOW); . 
functions, each does the same thing, but use  

Type away, regardless of what you change you won't 
different approaches (hint the second one uses a 

break anything.
for loop)

10

CIRC-02

What We’re Doing:

.:8 LED Fun:.

.:Multiple LED’s:.

We have caused one LED to blink, now its time to up the 

stakes. Lets connect eight. We'll also have an opportunity to 

stretch the Arduino a bit by creating various lighting sequences. 

This circuit is also a nice setup to experiment with writing your 

own programs and getting a feel for how the Arduino works.

Along with controlling the LEDs we start looking into a few simple programming methods to 

keep your programs small. 

for() loops - used when you want to run a piece of code several times.

arrays[] - used to make managing variables easier (its a group of variables)

The Circuit:

Wire

  

5mm GreenLED

x8

560 Ohm Resistor
Green-Blue-Brown

x8

2 Pin Header

x4

CIRC-02 

Breadboard sheet

x1

Parts:

.:download:.
printable 

breadboard overlay
http://tinyurl.com/d4gmov

.

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/coafoh

The Internet

Schematic:
Arduino 

pin 5

LED
(light emitting diode)

resistor (560ohm)

(blue-green-brown)

gnd
(ground) (-)

Arduino 
pin 9

LED
(light emitting diode)

resistor (560ohm)

(blue-green-brown)

gnd
(ground) (-)

Arduino 
pin 4

Arduino 
pin 8

Arduino 
pin 3

Arduino 
pin 7

Arduino 
pin 2

Arduino 
pin 6

Starting Afresh

Its easy to accidentally 

misplace a wire without 

noticing. Pulling everything out 

and starting with a fresh slate 

is often easier than trying to 

track down the problem.



Operating out of sequence  

With eight wires it's easy to cross 

a couple. Double check that the 

first LED is plugged into pin 2 and 

each pin there after.
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CIRC-02Code (no need to type everything in just)

Download the Code from ( http://tinyurl.com/dkpxbn )
(and then copy the text and paste it into an empty Arduino Sketch)

 
//LED Pin Variables * will then turn them off 
int ledPins[] = {2,3,4,5,6,7,8,9};
              //An array to hold the        void oneAfterAnotherNoLoop(){
              //pin each LED is connected to   int delayTime = 100; 
              //i.e. LED #0 is connected to pin 2            / / t h e   t i m e   ( i n   m i l l i s e c o n d s )   t o   p a u s e                    

     //between LEDs
void setup()   digitalWrite(ledPins[0], HIGH);  //Turns on LED #0 
{                                 //(connected to pin 2)
  for(int i = 0; i < 8; i++){   delay(delayTime);     //waits delayTime milliseconds
     //this is a loop and will repeat eight times   ...
    pinMode(ledPins[i],OUTPUT);   ...
     //we use this to set LED pins to output   digitalWrite(ledPins[7], HIGH);  //Turns on LED #7 
  }                                                                  //(connected to pin 9)
}   delay(delayTime);    //waits delayTime milliseconds  

//Turns Each LED Off
void loop()          // run over and over again   digitalWrite(ledPins[7], LOW);  //Turns off LED #7
{   delay(delayTime);    //waits delayTime milliseconds
  oneAfterAnotherNoLoop();     ...
      //this will turn on each LED one by 
      //one then turn each oneoff -----more code in the downloadable version------        
  //oneAfterAnotherLoop();   
     //this does the same as onAfterAnotherNoLoop
     //but with much less typing
  //oneOnAtATime();          
  //inAndOut();               
}

/*
 * oneAfterAnotherNoLoop() - Will light one then 
 * delay for delayTime then light the next LED it 

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/d2hrud

Making it Better

Some LEDs Fail to Light 

 It is easy to insert an LED 

backwards. Check the LEDs 

that aren't working and ensure 

they the right way around.

Switching to Loops:
in the loop() function there are 4 lines. The last Extra Animations:

Tired of this animation? Then try the other two three all start with a '//' this means the line is 
sample animations. Uncomment their lines and treated as a comment (not run). To switch the 
upload the program to your board and enjoy the new program to use loops change the void loop() 
light animations. (delete the slashes in front of row 3 and then 4)code to:

  //oneAfterAnotherNoLoop();   
  oneAfterAnotherLoop();   
  //oneOnAtATime();          Testing out your own Animations:

Jump into the included code and start changing   //inAndOut();

things. The main point is to turn an LED on use 
Upload the program, and notice that nothing has 

digitalWrite(pinNumber, HIGH); then to turn 
changed. You can take a look at the two 

it off use digitalWrite(pinNumber, LOW); . 
functions, each does the same thing, but use  

Type away, regardless of what you change you won't 
different approaches (hint the second one uses a 

break anything.
for loop)
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CIRC-02

What We’re Doing:

.:8 LED Fun:.

.:Multiple LED’s:.

We have caused one LED to blink, now its time to up the 

stakes. Lets connect eight. We'll also have an opportunity to 

stretch the Arduino a bit by creating various lighting sequences. 

This circuit is also a nice setup to experiment with writing your 

own programs and getting a feel for how the Arduino works.

Along with controlling the LEDs we start looking into a few simple programming methods to 

keep your programs small. 

for() loops - used when you want to run a piece of code several times.

arrays[] - used to make managing variables easier (its a group of variables)

The Circuit:

Wire

  

5mm GreenLED

x8

560 Ohm Resistor
Green-Blue-Brown

x8

2 Pin Header

x4

CIRC-02 

Breadboard sheet

x1

Parts:

.:download:.
printable 

breadboard overlay
http://tinyurl.com/d4gmov

.

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/coafoh

The Internet

Schematic:
Arduino 

pin 5

LED
(light emitting diode)

resistor (560ohm)

(blue-green-brown)

gnd
(ground) (-)

Arduino 
pin 9

LED
(light emitting diode)

resistor (560ohm)

(blue-green-brown)

gnd
(ground) (-)

Arduino 
pin 4

Arduino 
pin 8

Arduino 
pin 3

Arduino 
pin 7

Arduino 
pin 2

Arduino 
pin 6

Starting Afresh

Its easy to accidentally 

misplace a wire without 

noticing. Pulling everything out 

and starting with a fresh slate 

is often easier than trying to 

track down the problem.



Transistor Getting Hot 

 The transistor will get warm, in 

most cases this is okay, if you 

are worried about the 

temperature turn the circuit off 

for a bit and let it cool down.
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CIRC-03Code (no need to type everything in just)

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/d4wht7

Making it Better

Motor Not Spinning? 

Different manufacturers 

produce the same transistor 

with different pin assignments. 

Try turning the transistor 180 

degrees.

Controlling Speed: In the loop() section change it to this 
// motorOnThenOff();We played with the Arduino's ability to control the 
   motorOnThenOffWithSpeed();

brightness of an LED earlier now we will use the same  //motorAcceleration();
Then upload the programme. You can change the speeds  by feature to control the speed of our motor. The arduino 

changing the variables onSpeed and offSpeeddoes this using something called Pulse Width 

Modulation (PWM). This relies on the Arduino's ability to 
Accelerating and decelerating:

operate really really fast. Rather than directly controlling 
Why stop at two speeds, why not accelerate and decelerate 

the voltage coming from the pin the Arduino will switch 
the motor. To do this simply change the loop() code to read
// motorOnThenOff();the pin on and off very quickly. In the computer world 
// motorOnThenOffWithSpeed();

this is going from 0 to 5 volts many times a second, but    motorAcceleration();
in the human world we see it as a voltage. For example 

Then upload the program and watch as your motor slowly if the Arduino is PWM'ing at 50% we see the light 
accelerates up to full speed then slows down again. If you dimmed 50% because our eyes are not quick enough to 
would like to change the speed of acceleration change the see it flashing on and off. The same feature works with 
variable delayTime (larger means a longer acceleration time)transistors. Don't believe me? Try it out.

Still Not Working? 

Sometimes the Arduino board 

will disconnect from the 

computer. Try un-plugging and 

then re-plugging it into your 

USB port. 

int motorPin = 9; //pin the motor is connected to
                  
void setup() //runs once void motorOnThenOffWithSpeed(){
{   int onSpeed = 200;// a number between 
 pinMode(motorPin, OUTPUT);                     //0 (stopped) and 255 (full speed) 
}   int onTime = 2500;    

  int offSpeed = 50;// a number between 
void loop()        // run over and over again                     //0 (stopped) and 255 (full speed) 
{   int offTime = 1000;   
 motorOnThenOff();   analogWrite(motorPin, onSpeed);   
 //motorOnThenOffWithSpeed();       // turns the motor On
 //motorAcceleration();   delay(onTime);      // waits for onTime milliseconds
}   analogWrite(motorPin, offSpeed);  

      // turns the motor Off
/*   delay(offTime);    // waits for offTime milliseconds
 * motorOnThenOff() - turns motor on then off }
 * (notice this code is identical to the code we 

void motorAcceleration(){used for
  int delayTime = 50; //time between each speed step * the blinking LED)
  for(int i = 0; i < 256; i++){ */
       //goes through each speed from 0 to 255void motorOnThenOff(){
   analogWrite(motorPin, i);   //sets the new speed  int onTime = 2500;  //on time
   delay(delayTime);// waits for delayTime milliseconds  int offTime = 1000; //off time
  }  digitalWrite(motorPin, HIGH); 
  for(int i = 255; i >= 0; i--){                 // turns the motor On
       //goes through each speed from 255 to 0  delay(onTime); // waits for onTime milliseconds
    analogWrite(motorPin, i);   //sets the new speed  digitalWrite(motorPin, LOW);  
    delay(delayTime);//waits for delayTime milliseconds                 // turns the motor Off
  }  delay(offTime);// waits for offTime milliseconds
}}

Download the Code from ( http://tinyurl.com/dagyrb )
(then simply copy the text and paste it into an empty Arduino Sketch)
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CIRC-03

What We’re Doing:

.:Spin Motor Spin:.

.:Transistor & Motor:.

The Arduino's pins are great for directly controlling small electric 

items like LEDs. However, when dealing with larger items (like a 

toy motor or washing machine), an external transistor is required. 

A transistor is incredibly useful. It switches a lot of current using a 

much smaller current. A transistor has 3 pins. For a negative type (NPN) 

transistor you connect your load to collector and the emitter to ground. Then when a small current 

flows from base to the emitter a current will flow through the transistor and your motor will spin (this 

happens when we set our Arduino pin HIGH). There are literally thousands of different types of 

transistors, allowing every situation to be perfectly matched. We have chosen a 2N222A a rather 

common general purpose transistor. The important factors in our case are that its maximum voltage 

(40 v) and its maximum current (600 milliamp) are both high enough for our toy motor (full details 

can be found on its datasheet http://tinyurl.com/o2cm93 ) 
(The 1N4001 diode is acting as a flyback diode for details on why its there visit: http://tinyurl.com/b559mx)

The Circuit:

Wire

Transistor

2N2222A (TO92)

x1

2.2k  Ohm Resistor

Red-Red-Red

x1

2 Pin Header

x4

CIRC-03 

Breadboard sheet

x1

Parts:

.:download:.
printable 

breadboard overlay
http://tinyurl.com/d6jv63

.

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/djapjg

The Internet

Toy Motor

x1

Schematic:
Arduino 
pin 9

resistor (2.2kohm)

(red-red-red)

gnd
(ground) (-)

Collector Emitter

Base

Toy
Motor

+5 volts

Transistor
2N2222A

the transistor will have 
2N222A printed on it
(some variations will have 
the pin assignment reversed)

Diode

(1N4001)

x1

Diode
(flyback)



Transistor Getting Hot 

 The transistor will get warm, in 

most cases this is okay, if you 

are worried about the 

temperature turn the circuit off 

for a bit and let it cool down.
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CIRC-03Code (no need to type everything in just)

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/d4wht7

Making it Better

Motor Not Spinning? 

Different manufacturers 

produce the same transistor 

with different pin assignments. 

Try turning the transistor 180 

degrees.

Controlling Speed: In the loop() section change it to this 
// motorOnThenOff();We played with the Arduino's ability to control the 
   motorOnThenOffWithSpeed();

brightness of an LED earlier now we will use the same  //motorAcceleration();
Then upload the programme. You can change the speeds  by feature to control the speed of our motor. The arduino 

changing the variables onSpeed and offSpeeddoes this using something called Pulse Width 

Modulation (PWM). This relies on the Arduino's ability to 
Accelerating and decelerating:

operate really really fast. Rather than directly controlling 
Why stop at two speeds, why not accelerate and decelerate 

the voltage coming from the pin the Arduino will switch 
the motor. To do this simply change the loop() code to read
// motorOnThenOff();the pin on and off very quickly. In the computer world 
// motorOnThenOffWithSpeed();

this is going from 0 to 5 volts many times a second, but    motorAcceleration();
in the human world we see it as a voltage. For example 

Then upload the program and watch as your motor slowly if the Arduino is PWM'ing at 50% we see the light 
accelerates up to full speed then slows down again. If you dimmed 50% because our eyes are not quick enough to 
would like to change the speed of acceleration change the see it flashing on and off. The same feature works with 
variable delayTime (larger means a longer acceleration time)transistors. Don't believe me? Try it out.

Still Not Working? 

Sometimes the Arduino board 

will disconnect from the 

computer. Try un-plugging and 

then re-plugging it into your 

USB port. 

int motorPin = 9; //pin the motor is connected to
                  
void setup() //runs once void motorOnThenOffWithSpeed(){
{   int onSpeed = 200;// a number between 
 pinMode(motorPin, OUTPUT);                     //0 (stopped) and 255 (full speed) 
}   int onTime = 2500;    

  int offSpeed = 50;// a number between 
void loop()        // run over and over again                     //0 (stopped) and 255 (full speed) 
{   int offTime = 1000;   
 motorOnThenOff();   analogWrite(motorPin, onSpeed);   
 //motorOnThenOffWithSpeed();       // turns the motor On
 //motorAcceleration();   delay(onTime);      // waits for onTime milliseconds
}   analogWrite(motorPin, offSpeed);  

      // turns the motor Off
/*   delay(offTime);    // waits for offTime milliseconds
 * motorOnThenOff() - turns motor on then off }
 * (notice this code is identical to the code we 

void motorAcceleration(){used for
  int delayTime = 50; //time between each speed step * the blinking LED)
  for(int i = 0; i < 256; i++){ */
       //goes through each speed from 0 to 255void motorOnThenOff(){
   analogWrite(motorPin, i);   //sets the new speed  int onTime = 2500;  //on time
   delay(delayTime);// waits for delayTime milliseconds  int offTime = 1000; //off time
  }  digitalWrite(motorPin, HIGH); 
  for(int i = 255; i >= 0; i--){                 // turns the motor On
       //goes through each speed from 255 to 0  delay(onTime); // waits for onTime milliseconds
    analogWrite(motorPin, i);   //sets the new speed  digitalWrite(motorPin, LOW);  
    delay(delayTime);//waits for delayTime milliseconds                 // turns the motor Off
  }  delay(offTime);// waits for offTime milliseconds
}}

Download the Code from ( http://tinyurl.com/dagyrb )
(then simply copy the text and paste it into an empty Arduino Sketch)
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CIRC-03

What We’re Doing:

.:Spin Motor Spin:.

.:Transistor & Motor:.

The Arduino's pins are great for directly controlling small electric 

items like LEDs. However, when dealing with larger items (like a 

toy motor or washing machine), an external transistor is required. 

A transistor is incredibly useful. It switches a lot of current using a 

much smaller current. A transistor has 3 pins. For a negative type (NPN) 

transistor you connect your load to collector and the emitter to ground. Then when a small current 

flows from base to the emitter a current will flow through the transistor and your motor will spin (this 

happens when we set our Arduino pin HIGH). There are literally thousands of different types of 

transistors, allowing every situation to be perfectly matched. We have chosen a 2N222A a rather 

common general purpose transistor. The important factors in our case are that its maximum voltage 

(40 v) and its maximum current (600 milliamp) are both high enough for our toy motor (full details 

can be found on its datasheet http://tinyurl.com/o2cm93 ) 
(The 1N4001 diode is acting as a flyback diode for details on why its there visit: http://tinyurl.com/b559mx)

The Circuit:

Wire

Transistor

2N2222A (TO92)

x1

2.2k  Ohm Resistor

Red-Red-Red

x1

2 Pin Header

x4

CIRC-03 

Breadboard sheet

x1

Parts:

.:download:.
printable 

breadboard overlay
http://tinyurl.com/d6jv63

.

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/djapjg

The Internet

Toy Motor

x1

Schematic:
Arduino 
pin 9

resistor (2.2kohm)

(red-red-red)

gnd
(ground) (-)

Collector Emitter

Base

Toy
Motor

+5 volts

Transistor
2N2222A

the transistor will have 
2N222A printed on it
(some variations will have 
the pin assignment reversed)

Diode

(1N4001)

x1

Diode
(flyback)



Still not Working

 Unfortunately some servos do 

break when plugged in 

backwards.
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CIRC-04Code (no need to type everything in just)

File > Sketchbook > Examples > Library-Servo > Sweep
(example from the great arduino.cc site check it out for other great ideas)

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/djwlop

Making it Better

Servo Not Twisting? 

Even with colored wires it is still 

shockingly easy to plug a servo 

in backwards. This might be the 

case.

Potentiometer Control:
void loop() {

We have yet to experiment with inputs but if you would like to   int pulseTime = 2100; //(the number of microseconds 
                        //to pause for (1500 90 degrees 

read ahead, there is an example program File > Sketchbook                         // 900 0 degrees 2100 180 degrees) 
  digitalWrite(servoPin, HIGH);> Examples > Library-Servo > Knob. This uses a 
  delayMicroseconds(pulseTime);
  digitalWrite(servoPin, LOW);potentiometer (CIRC08) to control the servo. You can find 
  delay(25);

instructions online here: http://tinyurl.com/dymsk2 }

Great Ideas:Self Timing:
Servos can be used to do all sorts of great things, here are a few of While it is easy to control a servo using the Arduino's included 

our favorites.library sometimes it is fun to figure out how to program 

something yourself. Try it. We're controlling the pulse directly 
Xmas Hit Counter

so you could use this method to control servos on any of the http://tinyurl.com/37djhq
Arduino's 20 available pins (you need to highly optimize this 

code before doing that). Open Source Robotic Arm (uses a servo controller as well as the Arduino)

http://tinyurl.com/ckm3wd
  int servoPin = 9;

void setup(){ Servo Walker
  pinMode(servoPin,OUTPUT);

http://tinyurl.com/da5jfe}

Sad Your Servo is Broken? 

 Don't worry they are only a few 

dollars, plus taking one apart is 

good fun (you can try running 

the motor directly with a 

transistor)

// Sweep
// by BARRAGAN <http://barraganstudio.com> 

#include <Servo.h>  
Servo myservo;  // create servo object to control a servo
int pos = 0;    // variable to store the servo position  

void setup() {   
  myservo.attach(9);  // attaches the servo on pin 9 to the servo object 
}

void loop() {   
  for(pos = 0; pos < 180; pos += 1)  // goes from 0 degrees to 180 degrees  
  {                                  // in steps of 1 degree     
    myservo.write(pos);          // tell servo to go to position in variable 'pos'        
    delay(15);                   // waits 15ms for the servo to reach the position    
  }
  for(pos = 180; pos>=1; pos-=1)     // goes from 180 degrees to 0 degrees   
  {                                    
    myservo.write(pos);          // tell servo to go to position in variable 'pos'     
    delay(15);                   // waits 15ms for the servo to reach the position   
  }
} 

14

CIRC-04

What We’re Doing:

.:A Single Servo:.

.:Servos:.

Spinning a motor is good fun but when it comes to projects 

where motion control is required they tend to leave us wanting 

more. The answer? Hobby servos. They are mass produced, 

widely available and cost anything from a couple of dollars to 

hundreds. Inside is a small gearbox (to make the movement more powerful) and some 

electronics (to make it easier to control). A standard servo is positionable from 0 to 180 

degrees. Positioning is controlled through a timed pulse, between 1.25 milliseconds (0 degrees) 

and 1.75 milliseconds (180 degrees) (1.5 milliseconds for 90 degrees). Timing varies between 

manufacturer. If the pulse is sent every 25-50 milliseconds the servo will run smoothly. One of 

the great features of the Arduino is it has a software library that allows you to control two 

servos (connected to pin 9 or 10) using a single line of code.

The Circuit:

Wire
3 Pin Header

x1

Mini Servo

x1

2 Pin Header

x4

CIRC-04

Breadboard sheet

x1

Parts:

Schematic:

.:download:.
printable 

breadboard overlay
http://tinyurl.com/db5fcm

.

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/d52954

The Internet

Arduino 
pin 9

gnd
(ground) (-)

gnd

signal

+5v

Mini Servo

+5 volts
(5V)



Still not Working

 Unfortunately some servos do 

break when plugged in 

backwards.

15

CIRC-04Code (no need to type everything in just)

File > Sketchbook > Examples > Library-Servo > Sweep
(example from the great arduino.cc site check it out for other great ideas)

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/djwlop

Making it Better

Servo Not Twisting? 

Even with colored wires it is still 

shockingly easy to plug a servo 

in backwards. This might be the 

case.

Potentiometer Control:
void loop() {

We have yet to experiment with inputs but if you would like to   int pulseTime = 2100; //(the number of microseconds 
                        //to pause for (1500 90 degrees 

read ahead, there is an example program File > Sketchbook                         // 900 0 degrees 2100 180 degrees) 
  digitalWrite(servoPin, HIGH);> Examples > Library-Servo > Knob. This uses a 
  delayMicroseconds(pulseTime);
  digitalWrite(servoPin, LOW);potentiometer (CIRC08) to control the servo. You can find 
  delay(25);

instructions online here: http://tinyurl.com/dymsk2 }

Great Ideas:Self Timing:
Servos can be used to do all sorts of great things, here are a few of While it is easy to control a servo using the Arduino's included 

our favorites.library sometimes it is fun to figure out how to program 

something yourself. Try it. We're controlling the pulse directly 
Xmas Hit Counter

so you could use this method to control servos on any of the http://tinyurl.com/37djhq
Arduino's 20 available pins (you need to highly optimize this 

code before doing that). Open Source Robotic Arm (uses a servo controller as well as the Arduino)

http://tinyurl.com/ckm3wd
  int servoPin = 9;

void setup(){ Servo Walker
  pinMode(servoPin,OUTPUT);

http://tinyurl.com/da5jfe}

Sad Your Servo is Broken? 

 Don't worry they are only a few 

dollars, plus taking one apart is 

good fun (you can try running 

the motor directly with a 

transistor)

// Sweep
// by BARRAGAN <http://barraganstudio.com> 

#include <Servo.h>  
Servo myservo;  // create servo object to control a servo
int pos = 0;    // variable to store the servo position  

void setup() {   
  myservo.attach(9);  // attaches the servo on pin 9 to the servo object 
}

void loop() {   
  for(pos = 0; pos < 180; pos += 1)  // goes from 0 degrees to 180 degrees  
  {                                  // in steps of 1 degree     
    myservo.write(pos);          // tell servo to go to position in variable 'pos'        
    delay(15);                   // waits 15ms for the servo to reach the position    
  }
  for(pos = 180; pos>=1; pos-=1)     // goes from 180 degrees to 0 degrees   
  {                                    
    myservo.write(pos);          // tell servo to go to position in variable 'pos'     
    delay(15);                   // waits 15ms for the servo to reach the position   
  }
} 
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CIRC-04

What We’re Doing:

.:A Single Servo:.

.:Servos:.

Spinning a motor is good fun but when it comes to projects 

where motion control is required they tend to leave us wanting 

more. The answer? Hobby servos. They are mass produced, 

widely available and cost anything from a couple of dollars to 

hundreds. Inside is a small gearbox (to make the movement more powerful) and some 

electronics (to make it easier to control). A standard servo is positionable from 0 to 180 

degrees. Positioning is controlled through a timed pulse, between 1.25 milliseconds (0 degrees) 

and 1.75 milliseconds (180 degrees) (1.5 milliseconds for 90 degrees). Timing varies between 

manufacturer. If the pulse is sent every 25-50 milliseconds the servo will run smoothly. One of 

the great features of the Arduino is it has a software library that allows you to control two 

servos (connected to pin 9 or 10) using a single line of code.

The Circuit:

Wire
3 Pin Header

x1

Mini Servo

x1

2 Pin Header

x4

CIRC-04

Breadboard sheet

x1

Parts:

Schematic:

.:download:.
printable 

breadboard overlay
http://tinyurl.com/db5fcm

.

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/d52954

The Internet

Arduino 
pin 9

gnd
(ground) (-)

gnd

signal

+5v

Mini Servo

+5 volts
(5V)



Not Quite Working

 Sorry to sound like a broken 

record but it is probably 

something as simple as  a 

crossed wire.
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CIRC-05Code (no need to type everything in just)

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/dkjno3

Making it Better

The Arduino’s Power 

LED goes out 
 This happened to us a couple 

of times, it happens when the 

chip is inserted backwards. If 

you fix it quickly nothing will 

break.

milliseconds to delay Doing it the hard way:
                       //between LED updatesAn Arduino makes rather complex actions very easy, shifting out data 
  for(int i = 0; i < 8; i++){

is one of these cases. However one of the nice features of an     changeLED(i,ON);
    delay(delayTime);Arduino is you can make things as easy or difficult as you like. Lets 
  }
  for(int i = 0; i < 8; i++){try an example of this. In your loop switch the line.
    changeLED(i,OFF);updateLEDs(i) -> updateLEDsLong(i);
    delay(delayTime);Upload the program and notice nothing has changed. If you look at 
  }

the code you can see how we are communicating with the chip one 

bit at a time. (for more details http://tinyurl.com/3augzd ) And upload this will cause the lights to light up one after another and then 

off in a similar manner. Check the code and wikipedia to see how it works, 
Controlling Individual LEDs:

or shoot us an e-mail if you have questions.Time to start controlling the LEDs in a similar method as we did in 

CIRC02. As the eight LED states are stored in one byte (an 8 bit 
More Animations:

value) for details on how this works try http://tinyurl.com/6vz53. An Now things get more interesting. If you look back to the code from CIRC02 

Arduino is very good at manipulating bits and there are an entire set (8 LED Fun) you see we change the LEDs using digitalWrite(led, state), this 

of operators that help us out. Details on bitwise maths ( is the same format as the routine we wrote changeLED(led, state). You can 

http://tinyurl.com/br8dd ) use the animations you wrote for CIRC02 by copying the code into this 

sketch and changing all the digitalWrite()'s to changeLED()'s. Powerful? 
Our implementation.

Very. (you'll also need to change a few other things but follow the compile Replace the loop() code with
   int delayTime = 100; //the number of errors and it works itself out)

Frustration?
Shoot us an e-mail, this circuit 

is both simple and complex at 

the same time. We want to 

hear about problems you have 

so we can address them in 

future editions.
 help@oomlout.com

Download the Code from ( http://tinyurl.com/cv4fjt )
(copy the text and paste it into an empty Arduino Sketch)

//Pin Definitions       
//The 74HC595 uses a protocol called SPI 
//Which has three pins //Pulls the chips latch low
int data = 2;   shiftOut(data, clock, MSBFIRST, value);   
int clock = 3;      //Shifts out 8 bits to the shift register 
int latch = 4;      

  
void setup()  //runs once digitalWrite(latch, HIGH);   
{      //Pulls the latch high displaying the data
  pinMode(data, OUTPUT); }
  pinMode(clock, OUTPUT);    
  pinMode(latch, OUTPUT);  }   ---------- More Code Online ----------

void loop()   // run over and over again
{
  int delayTime = 100; 
     //delay between LED updates
  for(int i = 0; i < 256; i++){
   updateLEDs(i);
   delay(delayTime);   }
}

/*
 * updateLEDs() - sends the LED states set
 * in value to the 74HC595 sequence
 */
void updateLEDs(int value){
  digitalWrite(latch, LOW);

16

CIRC-05

What We’re Doing:

.:8 More LED’s:.
.:74HC595 Shift Register:.

Time to start playing with chips. Or integrated circuits (ICs) as they like to be 

called. The external packaging of a chip can be very deceptive for example the 

chip on the Arduino board (a micro controller) and the one we will use in this 

circuit (a shift register) look very similar but are in fact rather different, for 

example the price of the Atmega chip on the arduino board is a few dollars while the 

74hc595 is a couple dozen cents. It's a good introductory chip, and once your comfortable playing around with it and its 

datasheet (available online http://tinyurl.com/pr42xe ) the world of chips will be your oyster. The shift register (also called 

a serial to parallel converter), will give you an additional 8 outputs (to control LEDs and the like) using only four arduino 

pins. They can also be linked together to give you a nearly unlimited number of outputs using the same four pins. To use 

it you “clock in” the data and then latch it. To do this you set the data pin to either HIGH or LOW, pulse the clock, then 

set the data pin again and pulse the clock repeating until you have shifted out 8 bits of data. Then you pulse the latch 

and the 8 bits are transferred to the shift registers pins. It sounds complicated but is really simple once you get the hang 

of it. 

(for a more in depth look at how a shift register works visit: http://tinyurl.com/56uvv7 )

The Circuit:

Wire 

Shift Register

74HC595

x1

560 Ohm Resistor
Green-Blue-Brown

x8

2 Pin Header

x4

CIRC-05 

Breadboard sheet

x1

Parts:

.:download:.
printable 

breadboard overlay
http://tinyurl.com/d8xepz.

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/c2enkv

The Internet

Red LED

x8

Schematic:
Arduino
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Not Quite Working

 Sorry to sound like a broken 

record but it is probably 

something as simple as  a 

crossed wire.

17

CIRC-05Code (no need to type everything in just)

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/dkjno3

Making it Better

The Arduino’s Power 

LED goes out 
 This happened to us a couple 

of times, it happens when the 

chip is inserted backwards. If 

you fix it quickly nothing will 

break.

milliseconds to delay Doing it the hard way:
                       //between LED updatesAn Arduino makes rather complex actions very easy, shifting out data 
  for(int i = 0; i < 8; i++){

is one of these cases. However one of the nice features of an     changeLED(i,ON);
    delay(delayTime);Arduino is you can make things as easy or difficult as you like. Lets 
  }
  for(int i = 0; i < 8; i++){try an example of this. In your loop switch the line.
    changeLED(i,OFF);updateLEDs(i) -> updateLEDsLong(i);
    delay(delayTime);Upload the program and notice nothing has changed. If you look at 
  }

the code you can see how we are communicating with the chip one 

bit at a time. (for more details http://tinyurl.com/3augzd ) And upload this will cause the lights to light up one after another and then 

off in a similar manner. Check the code and wikipedia to see how it works, 
Controlling Individual LEDs:

or shoot us an e-mail if you have questions.Time to start controlling the LEDs in a similar method as we did in 

CIRC02. As the eight LED states are stored in one byte (an 8 bit 
More Animations:

value) for details on how this works try http://tinyurl.com/6vz53. An Now things get more interesting. If you look back to the code from CIRC02 

Arduino is very good at manipulating bits and there are an entire set (8 LED Fun) you see we change the LEDs using digitalWrite(led, state), this 

of operators that help us out. Details on bitwise maths ( is the same format as the routine we wrote changeLED(led, state). You can 

http://tinyurl.com/br8dd ) use the animations you wrote for CIRC02 by copying the code into this 

sketch and changing all the digitalWrite()'s to changeLED()'s. Powerful? 
Our implementation.

Very. (you'll also need to change a few other things but follow the compile Replace the loop() code with
   int delayTime = 100; //the number of errors and it works itself out)

Frustration?
Shoot us an e-mail, this circuit 

is both simple and complex at 

the same time. We want to 

hear about problems you have 

so we can address them in 

future editions.
 help@oomlout.com

Download the Code from ( http://tinyurl.com/cv4fjt )
(copy the text and paste it into an empty Arduino Sketch)

//Pin Definitions       
//The 74HC595 uses a protocol called SPI 
//Which has three pins //Pulls the chips latch low
int data = 2;   shiftOut(data, clock, MSBFIRST, value);   
int clock = 3;      //Shifts out 8 bits to the shift register 
int latch = 4;      

  
void setup()  //runs once digitalWrite(latch, HIGH);   
{      //Pulls the latch high displaying the data
  pinMode(data, OUTPUT); }
  pinMode(clock, OUTPUT);    
  pinMode(latch, OUTPUT);  }   ---------- More Code Online ----------

void loop()   // run over and over again
{
  int delayTime = 100; 
     //delay between LED updates
  for(int i = 0; i < 256; i++){
   updateLEDs(i);
   delay(delayTime);   }
}

/*
 * updateLEDs() - sends the LED states set
 * in value to the 74HC595 sequence
 */
void updateLEDs(int value){
  digitalWrite(latch, LOW);
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CIRC-05

What We’re Doing:

.:8 More LED’s:.
.:74HC595 Shift Register:.

Time to start playing with chips. Or integrated circuits (ICs) as they like to be 

called. The external packaging of a chip can be very deceptive for example the 

chip on the Arduino board (a micro controller) and the one we will use in this 

circuit (a shift register) look very similar but are in fact rather different, for 

example the price of the Atmega chip on the arduino board is a few dollars while the 

74hc595 is a couple dozen cents. It's a good introductory chip, and once your comfortable playing around with it and its 

datasheet (available online http://tinyurl.com/pr42xe ) the world of chips will be your oyster. The shift register (also called 

a serial to parallel converter), will give you an additional 8 outputs (to control LEDs and the like) using only four arduino 

pins. They can also be linked together to give you a nearly unlimited number of outputs using the same four pins. To use 

it you “clock in” the data and then latch it. To do this you set the data pin to either HIGH or LOW, pulse the clock, then 

set the data pin again and pulse the clock repeating until you have shifted out 8 bits of data. Then you pulse the latch 

and the 8 bits are transferred to the shift registers pins. It sounds complicated but is really simple once you get the hang 

of it. 

(for a more in depth look at how a shift register works visit: http://tinyurl.com/56uvv7 )

The Circuit:

Wire 

Shift Register

74HC595

x1

560 Ohm Resistor
Green-Blue-Brown

x8

2 Pin Header

x4

CIRC-05 

Breadboard sheet

x1

Parts:

.:download:.
printable 

breadboard overlay
http://tinyurl.com/d8xepz.

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/c2enkv

The Internet
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Arduino 
pin 9

gnd
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Piezo
Element
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CIRC-06
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CIRC-06

What We’re Doing:

.:Music:.

.:Piezo Elements:.

To this point we have controlled light, motion, and 

electrons, Lets tackle sound next. But sound is an 

analog phenomena, how will our digital Arduino cope? 

We will once again rely on its incredible speed which will 

let it mimic analog behavior. To do this, we will attach a piezo element to one of 

the Arduino's digital pins. A piezo element makes a clicking sound each time it 

is pulsed with current. If we pulse it at the right frequency (ie. quickly enough) 

these clicks will run together to produce notes. Lets get to experimenting with 

it and get your Arduino playing 'Twinkle Twinkle Little Star'.

Can't Think While the 

Melody is Playing.

Just pull up the piezo element 

whilst you think, upload your 

program then plug it back in.

Code (no need to type everything in just)

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/cpf6so

Making it Better

No Sound

Given the size and shape of the 

piezo element it is easy to miss 

the right holes on the 

breadboard. Try double 

checking its placement.

char names[] = { 'c', 'd', 'e', 'f', 'g', 'a', 'b', Playing with the speed:
'C' };The timing for each note is calculated based on variables, 
int tones[] = { 1915, 1700, 1519, 1432, 1275, 1136, 

as such we can tweak the sound of each note or the 1014, 956 };

timing. To change the speed of the melody you need to Composing your own melodies:
The program is pre-set to play 'Twinkle Twinkle Little Star' change only one line.

int tempo = 300; ---> int tempo = (new #) however the way it is programmed makes changing the song 
Change it to a larger number to slow the melody down, 

easy. Each song is defined in one int and two arrays, the int 
or a smaller number to speed it up.

length defines the number of notes, the first array notes[] Tuning the notes:
defines each note, and the second beats[] defines how long If you are worried about the notes being a little out of 

each note is played. Some Examples:tune this can be fixed as well. The notes have been 
    Twinkle Twinkle Little Starcalculated based on a formula in the comment block at 
   int length = 15; 
   char notes[] = "ccggaagffeeddc "; the top of the program. But to tune individual notes just 
   int beats[] = { 1, 1, 1, 1, 1, 1, 2, 1, 1, 1, 1,   

adjust their values in the tones[] array up or down                    1, 1, 2, 4 };

    Happy Birthday (first line)  until they sound right. (each note is matched by its name 
   int length = 13; 
   char notes[] = "ccdcfeccdcgf "; in the names[] (array ie. c = 1915 )
   int beats[] = {1,1,1,1,1,2,1,1,1,1,1,2,4};

Tired of Twinkle Twinkle 

Little Star?

The code is written so you can 

easily add your own songs, 

check out the code below to 

get started. 

/* Melody     
 * (cleft) 2005 D. Cuartielles for K3
 *
 * This example uses a piezo speaker to play melodies.  It sends     digitalWrite(speakerPin, LOW);
 * a square wave of the appropriate frequency to the piezo,     delayMicroseconds(tone);
 * generating the corresponding tone.   }
 * }
 * The calculation of the tones is made following the 
 * mathematical operation: void playNote(char note, int duration) {
 *   char names[] = { 'c', 'd', 'e', 'f', 'g', 'a', 'b', 'C' };
 *       timeHigh = period / 2 = 1 / (2 * toneFrequency)   int tones[] = { 1915, 1700, 1519, 1432, 1275, 1136, 1014, 956 
 * };
 * where the different tones are described as in the table:     // play the tone corresponding to the note name
 *   for (int i = 0; i < 8; i++) {
 * note frequency period timeHigh     if (names[i] == note) {
 * c         261 Hz         3830 1915        playTone(tones[i], duration);
 * d         294 Hz         3400 1700      }
 * e         329 Hz         3038 1519    }
 * f         349 Hz         2864 1432  }
 * g         392 Hz         2550 1275  
 * a         440 Hz         2272 1136  void setup() {
 * b         493 Hz         2028 1014    pinMode(speakerPin, OUTPUT);
 * C         523 Hz         1912 956 }
 *
 * http://www.arduino.cc/en/Tutorial/Melody void loop() {
 */   for (int i = 0; i < length; i++) {
     if (notes[i] == ' ') {
int speakerPin = 9;       delay(beats[i] * tempo); // rest

    } else {
int length = 15; // the number of notes       playNote(notes[i], beats[i] * tempo);
char notes[] = "ccggaagffeeddc "; // a space represents a rest     }
int beats[] = { 1, 1, 1, 1, 1, 1, 2, 1, 1, 1, 1, 1, 1, 2, 4 };         // pause between notes
int tempo = 300;     delay(tempo / 2);   }

}
void playTone(int tone, int duration) {
  for (long i = 0; i < duration * 1000L; i += tone * 2) {
    digitalWrite(speakerPin, HIGH);
    delayMicroseconds(tone);

The Circuit:

Wire

  

Piezo Element

x1

2 Pin Header

x4

CIRC-06

Breadboard sheet

x1

Parts:

.:download:.
printable 

breadboard overlay
http://tinyurl.com/c94aml

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/mnh33o

The Internet

Schematic:

File > Sketchbook > Examples > Digital > Melody
(example from the great arduino.cc site check it out for other great ideas)
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What We’re Doing:

.:Music:.

.:Piezo Elements:.

To this point we have controlled light, motion, and 

electrons, Lets tackle sound next. But sound is an 

analog phenomena, how will our digital Arduino cope? 

We will once again rely on its incredible speed which will 

let it mimic analog behavior. To do this, we will attach a piezo element to one of 

the Arduino's digital pins. A piezo element makes a clicking sound each time it 

is pulsed with current. If we pulse it at the right frequency (ie. quickly enough) 

these clicks will run together to produce notes. Lets get to experimenting with 

it and get your Arduino playing 'Twinkle Twinkle Little Star'.

Can't Think While the 

Melody is Playing.

Just pull up the piezo element 

whilst you think, upload your 

program then plug it back in.

Code (no need to type everything in just)

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/cpf6so

Making it Better

No Sound

Given the size and shape of the 

piezo element it is easy to miss 

the right holes on the 

breadboard. Try double 

checking its placement.

char names[] = { 'c', 'd', 'e', 'f', 'g', 'a', 'b', Playing with the speed:
'C' };The timing for each note is calculated based on variables, 
int tones[] = { 1915, 1700, 1519, 1432, 1275, 1136, 

as such we can tweak the sound of each note or the 1014, 956 };

timing. To change the speed of the melody you need to Composing your own melodies:
The program is pre-set to play 'Twinkle Twinkle Little Star' change only one line.

int tempo = 300; ---> int tempo = (new #) however the way it is programmed makes changing the song 
Change it to a larger number to slow the melody down, 

easy. Each song is defined in one int and two arrays, the int 
or a smaller number to speed it up.

length defines the number of notes, the first array notes[] Tuning the notes:
defines each note, and the second beats[] defines how long If you are worried about the notes being a little out of 

each note is played. Some Examples:tune this can be fixed as well. The notes have been 
    Twinkle Twinkle Little Starcalculated based on a formula in the comment block at 
   int length = 15; 
   char notes[] = "ccggaagffeeddc "; the top of the program. But to tune individual notes just 
   int beats[] = { 1, 1, 1, 1, 1, 1, 2, 1, 1, 1, 1,   

adjust their values in the tones[] array up or down                    1, 1, 2, 4 };

    Happy Birthday (first line)  until they sound right. (each note is matched by its name 
   int length = 13; 
   char notes[] = "ccdcfeccdcgf "; in the names[] (array ie. c = 1915 )
   int beats[] = {1,1,1,1,1,2,1,1,1,1,1,2,4};

Tired of Twinkle Twinkle 

Little Star?

The code is written so you can 

easily add your own songs, 

check out the code below to 

get started. 

/* Melody     
 * (cleft) 2005 D. Cuartielles for K3
 *
 * This example uses a piezo speaker to play melodies.  It sends     digitalWrite(speakerPin, LOW);
 * a square wave of the appropriate frequency to the piezo,     delayMicroseconds(tone);
 * generating the corresponding tone.   }
 * }
 * The calculation of the tones is made following the 
 * mathematical operation: void playNote(char note, int duration) {
 *   char names[] = { 'c', 'd', 'e', 'f', 'g', 'a', 'b', 'C' };
 *       timeHigh = period / 2 = 1 / (2 * toneFrequency)   int tones[] = { 1915, 1700, 1519, 1432, 1275, 1136, 1014, 956 
 * };
 * where the different tones are described as in the table:     // play the tone corresponding to the note name
 *   for (int i = 0; i < 8; i++) {
 * note frequency period timeHigh     if (names[i] == note) {
 * c         261 Hz         3830 1915        playTone(tones[i], duration);
 * d         294 Hz         3400 1700      }
 * e         329 Hz         3038 1519    }
 * f         349 Hz         2864 1432  }
 * g         392 Hz         2550 1275  
 * a         440 Hz         2272 1136  void setup() {
 * b         493 Hz         2028 1014    pinMode(speakerPin, OUTPUT);
 * C         523 Hz         1912 956 }
 *
 * http://www.arduino.cc/en/Tutorial/Melody void loop() {
 */   for (int i = 0; i < length; i++) {
     if (notes[i] == ' ') {
int speakerPin = 9;       delay(beats[i] * tempo); // rest

    } else {
int length = 15; // the number of notes       playNote(notes[i], beats[i] * tempo);
char notes[] = "ccggaagffeeddc "; // a space represents a rest     }
int beats[] = { 1, 1, 1, 1, 1, 1, 2, 1, 1, 1, 1, 1, 1, 2, 4 };         // pause between notes
int tempo = 300;     delay(tempo / 2);   }

}
void playTone(int tone, int duration) {
  for (long i = 0; i < duration * 1000L; i += tone * 2) {
    digitalWrite(speakerPin, HIGH);
    delayMicroseconds(tone);

The Circuit:

Wire

  

Piezo Element

x1

2 Pin Header

x4

CIRC-06

Breadboard sheet

x1

Parts:

.:download:.
printable 

breadboard overlay
http://tinyurl.com/c94aml

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/mnh33o

The Internet

Schematic:

File > Sketchbook > Examples > Digital > Melody
(example from the great arduino.cc site check it out for other great ideas)



Light Not Fading 

A bit of a silly mistake we 

constantly made, when you 

switch from simple on off to 

fading remember to move the 

LED wire from pin 13 to pin 9
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CIRC-07Code (no need to type everything in just)

File > Sketchbook > Examples > Digital > Button
(example from the great arduino.cc site check it out for other great ideas)

/*
 * Button
 * by DojoDave <http://www.0j0.org>
 *
 * Turns on and off a light emitting diode(LED) connected to digital   * pin 13, 

when pressing a pushbutton attached to pin 7.  *
 * http://www.arduino.cc/en/Tutorial/Button
 */
 int ledPin = 13;                // choose the pin for the LED
int inputPin = 2;               // choose the input pin (for a pushbutton)
int val = 0;                    // variable for reading the pin status

void setup() {
  pinMode(ledPin, OUTPUT);      // declare LED as output
  pinMode(inputPin, INPUT);     // declare pushbutton as input
}

void loop(){
  val = digitalRead(inputPin);  // read input value
  if (val == HIGH) {            // check if the input is HIGH
    digitalWrite(ledPin, LOW);  // turn LED OFF
  } else {
    digitalWrite(ledPin, HIGH); // turn LED ON
  }
}

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/c64tmt

Making it Better

Light Not Turning On 

 The pushbutton is square and 

because of this it is easy to put 

it in the wrong way. Give it a 90 

degree twist and see if it starts 

working.

On button off button: Fading up and down:
The initial example may be a little underwhelming (ie. I Lets use the buttons to control an analog signal. To do this you 

don't really need an Arduino to do this), lets make it a will need to change the wire connecting the LED from pin 13 to 

little more complicated. One button will turn the LED on pin 9, also change this in code.
int ledPin = 13; ----> int ledPin = 9;

the other will turn the LED off. Change the code to.
Next change the loop() code to read.int ledPin = 13;        // choose the pin for the LED

int inputPin1 = 3;      // button 1 int value = 0;
int inputPin2 = 2;      // button 2 void loop(){

  if (digitalRead(inputPin1) == LOW) { value--; } 
void setup() {   else if (digitalRead(inputPin2) == LOW) { value++; }
  pinMode(ledPin, OUTPUT);   // declare LED as output   value = constrain(value, 0, 255);
  pinMode(inputPin1, INPUT); // make button 1 an input   analogWrite(ledPin, value);
  pinMode(inputPin2, INPUT); // make button 2 an input   delay(10);
} }

void loop(){
Changing Fade Speed:  if (digitalRead(inputPin1) == LOW) { 

    digitalWrite(ledPin, LOW);  // turn LED OFF If you would like the LED to fade faster or slower, there is only   } else if (digitalRead(inputPin2) == LOW) {      
    digitalWrite(ledPin, HIGH); // turn LED ON one line of code that needs changing;
  }

delay(10);  ----> delay(new #);}
To fade faster make the number smaller, slower requires a Upload the program to your board, and start toggling the 
larger number.LED on and off.

Underwhelmed? 

No worries these circuits are all 

super stripped down to make 

playing with the components 

easy, but once you throw them 

together the sky is the limit.
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What We’re Doing:

.:Button Pressing:.

.:Pushbuttons:.

Up to this point we have focused entirely on outputs, time to 

get our Arduino to listen, watch and feel. We'll start with a 

simple pushbutton. Wiring up the pushbutton is simple. There is 

one component, the pull up resistor, that might seem out of place. 

This is included because an Arduino doesn't sense the same way we do (ie button pressed, 

button unpressed). Instead it looks at the voltage on the pin and decides whether it is HIGH or 

LOW. The button is set up to pull the Arduino's pin LOW when it is pressed, however, when the 

button is unpressed the voltage of the pin will float (causing occasional errors). To get the 

Arduino to reliably read the pin as HIGH when the button is unpressed, we add the pull up 

resistor. 

(note: the first example program uses only one of the two buttons)

The Circuit:

Wire
Pushbutton

x2

560 Ohm Resistor
Green-Blue-Brown

x1

2 Pin Header

x4

CIRC-07 

Breadboard sheet

x1

Parts:

.:download:.
printable 

breadboard overlay
http://tinyurl.com/dzmh8w

.

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/dnln6g

The Internet

Red LED

x1

10k Ohm Resistor
Brown-Black-Red

x2

Schematic:
Arduino 
pin 13

LED
(light emitting 
 diode)

resistor (560ohm)

(blue-green-brown)

gnd
(ground) (-)

pin 2

pushbutton

pin 3

+5 volts

Arduino

resistor
 (10k ohm)

(brown-black-red)



Light Not Fading 

A bit of a silly mistake we 

constantly made, when you 

switch from simple on off to 

fading remember to move the 

LED wire from pin 13 to pin 9
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CIRC-07Code (no need to type everything in just)

File > Sketchbook > Examples > Digital > Button
(example from the great arduino.cc site check it out for other great ideas)

/*
 * Button
 * by DojoDave <http://www.0j0.org>
 *
 * Turns on and off a light emitting diode(LED) connected to digital   * pin 13, 

when pressing a pushbutton attached to pin 7.  *
 * http://www.arduino.cc/en/Tutorial/Button
 */
 int ledPin = 13;                // choose the pin for the LED
int inputPin = 2;               // choose the input pin (for a pushbutton)
int val = 0;                    // variable for reading the pin status

void setup() {
  pinMode(ledPin, OUTPUT);      // declare LED as output
  pinMode(inputPin, INPUT);     // declare pushbutton as input
}

void loop(){
  val = digitalRead(inputPin);  // read input value
  if (val == HIGH) {            // check if the input is HIGH
    digitalWrite(ledPin, LOW);  // turn LED OFF
  } else {
    digitalWrite(ledPin, HIGH); // turn LED ON
  }
}

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/c64tmt

Making it Better

Light Not Turning On 

 The pushbutton is square and 

because of this it is easy to put 

it in the wrong way. Give it a 90 

degree twist and see if it starts 

working.

On button off button: Fading up and down:
The initial example may be a little underwhelming (ie. I Lets use the buttons to control an analog signal. To do this you 

don't really need an Arduino to do this), lets make it a will need to change the wire connecting the LED from pin 13 to 

little more complicated. One button will turn the LED on pin 9, also change this in code.
int ledPin = 13; ----> int ledPin = 9;

the other will turn the LED off. Change the code to.
Next change the loop() code to read.int ledPin = 13;        // choose the pin for the LED

int inputPin1 = 3;      // button 1 int value = 0;
int inputPin2 = 2;      // button 2 void loop(){

  if (digitalRead(inputPin1) == LOW) { value--; } 
void setup() {   else if (digitalRead(inputPin2) == LOW) { value++; }
  pinMode(ledPin, OUTPUT);   // declare LED as output   value = constrain(value, 0, 255);
  pinMode(inputPin1, INPUT); // make button 1 an input   analogWrite(ledPin, value);
  pinMode(inputPin2, INPUT); // make button 2 an input   delay(10);
} }

void loop(){
Changing Fade Speed:  if (digitalRead(inputPin1) == LOW) { 

    digitalWrite(ledPin, LOW);  // turn LED OFF If you would like the LED to fade faster or slower, there is only   } else if (digitalRead(inputPin2) == LOW) {      
    digitalWrite(ledPin, HIGH); // turn LED ON one line of code that needs changing;
  }

delay(10);  ----> delay(new #);}
To fade faster make the number smaller, slower requires a Upload the program to your board, and start toggling the 
larger number.LED on and off.

Underwhelmed? 

No worries these circuits are all 

super stripped down to make 

playing with the components 

easy, but once you throw them 

together the sky is the limit.
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What We’re Doing:

.:Button Pressing:.

.:Pushbuttons:.

Up to this point we have focused entirely on outputs, time to 

get our Arduino to listen, watch and feel. We'll start with a 

simple pushbutton. Wiring up the pushbutton is simple. There is 

one component, the pull up resistor, that might seem out of place. 

This is included because an Arduino doesn't sense the same way we do (ie button pressed, 

button unpressed). Instead it looks at the voltage on the pin and decides whether it is HIGH or 

LOW. The button is set up to pull the Arduino's pin LOW when it is pressed, however, when the 

button is unpressed the voltage of the pin will float (causing occasional errors). To get the 

Arduino to reliably read the pin as HIGH when the button is unpressed, we add the pull up 

resistor. 

(note: the first example program uses only one of the two buttons)

The Circuit:

Wire
Pushbutton

x2

560 Ohm Resistor
Green-Blue-Brown

x1

2 Pin Header

x4

CIRC-07 

Breadboard sheet

x1

Parts:

.:download:.
printable 

breadboard overlay
http://tinyurl.com/dzmh8w

.

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/dnln6g

The Internet

Red LED

x1

10k Ohm Resistor
Brown-Black-Red

x2

Schematic:
Arduino 
pin 13
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(light emitting 
 diode)

resistor (560ohm)

(blue-green-brown)

gnd
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pushbutton
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Arduino
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 (10k ohm)
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The Control is Backward 

There are two ways to fix this, 

either switch the red and black 

wires connected to the 

potentiometer, or turn the 

potentiometer around. (sorry 

sometimes the factory ships us a 

backwards potentiometer)

23

CIRC-08Code (no need to type everything in just)

File > Sketchbook > Examples > Analog > AnalogInput
(example from the great arduino.cc site check it out for other great ideas)

/*
 * AnalogInput
 * by DojoDave <http://www.0j0.org>
 *
 * Turns on and off a light emitting diode(LED) connected to digital   * pin 13. The amount of 

time the LED will be on and off depends on
 * the value obtained by analogRead(). In the easiest case we connect
 * a potentiometer to analog pin 2.
 *
 * http://www.arduino.cc/en/Tutorial/AnalogInput
 */

int potPin = 2;    // select the input pin for the potentiometer
int ledPin = 13;   // select the pin for the LED
int val = 0;       // variable to store the value coming from the sensor

void setup() {
  pinMode(ledPin, OUTPUT);  // declare the ledPin as an OUTPUT
}

void loop() {
  val = analogRead(potPin);    // read the value from the sensor
  digitalWrite(ledPin, HIGH);  // turn the ledPin on
  delay(val);                  // stop the program for some time
  digitalWrite(ledPin, LOW);   // turn the ledPin off
  delay(val);                  // stop the program for some time
}

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/cva3kq

Making it Better

 Sporadically Working 

This is most likely due to a 

slightly dodgy connection with 

the potentiometer's pins. This 

can usually be conquered by 

taping the potentiometer down.

Threshold Switching: Then change the loop code to.
  void loop() {Sometimes you will want to switch an output when a 
   int value = analogRead(potPin) / 4;
   analogWrite(ledPin, value);value exceeds a certain threshold. To do this with a 
  }

potentiometer change the loop() code to.
Upload the code and watch as your LED fades in relation to 

void loop() {
your potentiometer spinning. (Note: the reason we divide the   int threshold = 512;

  if(analogRead(potPin) > threshold){ value by 4 is the analogRead() function returns a value from 0 
digitalWrite(ledPin, HIGH);}

to 1024 (10 bits), and analogWrite() takes a value from 0 to   else{ digitalWrite(ledPin, LOW);}
} 255 (8 bits) )
This will cause the LED to turn on when the value is Controlling a Servo:
above 512 (about halfway), you can adjust the sensitivity This is a really neat example and brings a couple of circuits 

by changing the threshold value. together. Wire up the servo like you did in CIRC-04, then open 
Fading: the example program Knob (File > Sketchbook > Examples 
Lets control the brightness of an LED directly from the 

> Library-Servo > Knob ), then change one line of code.
potentiometer. To do this we need to first change the pin int potpin = 0; ----> int potpin = 2;

Upload to your Arduino and then watch as the servo shaft the LED is connected to. Move the wire from pin 13 to 

turns as you turn the potentiometer.  pin 9 and change one line in the code.
int ledPin = 13; ----> int ledPin = 9;

Still Backward

 You can try operating the 

circuit upside down. Sometimes 

this helps.
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What We’re Doing:

.:Twisting:.

.:Potentiometers:.

Along with the digital pins the Arduino has it also 

has 6 pins which can be used for analog input. 

These inputs take a voltage (from 0 to 5 volts) and 

convert it to a digital number between 0 (0 volts) and 

1024 (5 volts) (10 bits of resolution). A very useful device that exploits these 

inputs is a potentiometer (also called a variable resistor). When it is connected 

with 5 volts across its outer pins the middle pin will read some value between 0 

and 5 volts dependent on the angle to which it is turned (ie. 2.5 volts in the 

middle). We can then use the returned values as a variable in our program.

The Circuit:

WirePotentiometer

10k ohm

x1

560 Ohm Resistor
Green-Blue-Brown

x1

2 Pin Header

x4

CIRC-08 

Breadboard sheet

x1

Parts:

.:download:.
printable 

breadboard overlay
http://tinyurl.com/d62o7q.

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/cormru

The Internet

Green LED

x1

Schematic:
Arduino 
pin 13

LED
(light 
emitting 
diode)

resistor (560ohm)

(blue-green-brown)

gnd
(ground) (-)

Potentiometer

+5 volts

Arduino 
analog
pin 2



The Control is Backward 

There are two ways to fix this, 

either switch the red and black 

wires connected to the 

potentiometer, or turn the 

potentiometer around. (sorry 

sometimes the factory ships us a 

backwards potentiometer)

23

CIRC-08Code (no need to type everything in just)

File > Sketchbook > Examples > Analog > AnalogInput
(example from the great arduino.cc site check it out for other great ideas)

/*
 * AnalogInput
 * by DojoDave <http://www.0j0.org>
 *
 * Turns on and off a light emitting diode(LED) connected to digital   * pin 13. The amount of 

time the LED will be on and off depends on
 * the value obtained by analogRead(). In the easiest case we connect
 * a potentiometer to analog pin 2.
 *
 * http://www.arduino.cc/en/Tutorial/AnalogInput
 */

int potPin = 2;    // select the input pin for the potentiometer
int ledPin = 13;   // select the pin for the LED
int val = 0;       // variable to store the value coming from the sensor

void setup() {
  pinMode(ledPin, OUTPUT);  // declare the ledPin as an OUTPUT
}

void loop() {
  val = analogRead(potPin);    // read the value from the sensor
  digitalWrite(ledPin, HIGH);  // turn the ledPin on
  delay(val);                  // stop the program for some time
  digitalWrite(ledPin, LOW);   // turn the ledPin off
  delay(val);                  // stop the program for some time
}

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/cva3kq

Making it Better

 Sporadically Working 

This is most likely due to a 

slightly dodgy connection with 

the potentiometer's pins. This 

can usually be conquered by 

taping the potentiometer down.

Threshold Switching: Then change the loop code to.
  void loop() {Sometimes you will want to switch an output when a 
   int value = analogRead(potPin) / 4;
   analogWrite(ledPin, value);value exceeds a certain threshold. To do this with a 
  }

potentiometer change the loop() code to.
Upload the code and watch as your LED fades in relation to 

void loop() {
your potentiometer spinning. (Note: the reason we divide the   int threshold = 512;

  if(analogRead(potPin) > threshold){ value by 4 is the analogRead() function returns a value from 0 
digitalWrite(ledPin, HIGH);}

to 1024 (10 bits), and analogWrite() takes a value from 0 to   else{ digitalWrite(ledPin, LOW);}
} 255 (8 bits) )
This will cause the LED to turn on when the value is Controlling a Servo:
above 512 (about halfway), you can adjust the sensitivity This is a really neat example and brings a couple of circuits 

by changing the threshold value. together. Wire up the servo like you did in CIRC-04, then open 
Fading: the example program Knob (File > Sketchbook > Examples 
Lets control the brightness of an LED directly from the 

> Library-Servo > Knob ), then change one line of code.
potentiometer. To do this we need to first change the pin int potpin = 0; ----> int potpin = 2;

Upload to your Arduino and then watch as the servo shaft the LED is connected to. Move the wire from pin 13 to 

turns as you turn the potentiometer.  pin 9 and change one line in the code.
int ledPin = 13; ----> int ledPin = 9;

Still Backward

 You can try operating the 

circuit upside down. Sometimes 

this helps.
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What We’re Doing:

.:Twisting:.

.:Potentiometers:.

Along with the digital pins the Arduino has it also 

has 6 pins which can be used for analog input. 

These inputs take a voltage (from 0 to 5 volts) and 

convert it to a digital number between 0 (0 volts) and 

1024 (5 volts) (10 bits of resolution). A very useful device that exploits these 

inputs is a potentiometer (also called a variable resistor). When it is connected 

with 5 volts across its outer pins the middle pin will read some value between 0 

and 5 volts dependent on the angle to which it is turned (ie. 2.5 volts in the 

middle). We can then use the returned values as a variable in our program.

The Circuit:

WirePotentiometer

10k ohm

x1

560 Ohm Resistor
Green-Blue-Brown

x1

2 Pin Header

x4

CIRC-08 

Breadboard sheet

x1

Parts:

.:download:.
printable 

breadboard overlay
http://tinyurl.com/d62o7q.

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/cormru

The Internet

Green LED

x1

Schematic:
Arduino 
pin 13

LED
(light 
emitting 
diode)

resistor (560ohm)

(blue-green-brown)

gnd
(ground) (-)

Potentiometer

+5 volts

Arduino 
analog
pin 2



Frustration?
Shoot us an e-mail, this circuit 

is both simple and complex at 

the same time. We want to 

hear about problems you have 

so we can address them in 

future editions.
 help@oomlout.com

It Isn't Responding to 

Changes in Light.

Given that the spacing of the 

wires on the photo-resistor is 

not standad, it is easy to 

misplace it. Double check its in 

the right place
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CIRC-09Code (no need to type everything in just)

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/cpa83c

Making it Better

LED is Remaining Dark

This is a mistake we continue 

to make time and time again, if 

only they could make an LED 

that worked both ways. Pull it 

up and give it a twist.

Reverse the response: Light controlled servo:
Perhaps you would like the opposite response. Don't Lets use our newly found light sensing skills to control a servo 

worry we can easily reverse this response just change. (and at the same time engage in a little bit of Arduino code 

 analogWrite(ledPin, lightLevel); ----> hacking). Wire up a servo connected to pin 9 (like in CIRC-04). 
analogWrite(ledPin, 255 - lightLevel); Then open the Knob example program (the same one we used 

Upload and watch the response change.
in CIRC-08) File > Sketchbook > Examples > Library-

Servo > Knob. Upload the code to your board and watch as it Night light:
Rather than controlling the brightness of the LED in works unmodified.

Using the full range of your servo:response to light, lets instead turn it on or off based on a 
You'll notice that the servo will only operate over a limited 

threshold value. Change the loop() code with.
  void loop(){ portion of its range. This is because with the voltage dividing 
     int threshold = 300;

circuit we use the voltage on analog pin 0 will not range from      if(analogRead(lightPin) > threshold){
       digitalWrite(ledPin, HIGH); 0 to 5 volts but instead between two lesser values (these 
     }else{
       digitalWrite(ledPin, LOW);    values will change based on your setup). To  fix this play with 
     }

the val = map(val, 0, 1023, 0, 179); line. For hints on what to }

do visit http://arduino.cc/en/Reference/Map .

Download the Code from ( http://tinyurl.com/crdum6 )
(copy the text and paste it into an empty Arduino Sketch)

/* }
 * A simple programme that will change the  /*
 * intensity of an LED based  on the amount of  * loop() - this function will start after setup 
 * light incident on the photo resistor.  * finishes and then repeat
 *  */
 */ void loop()

{
//PhotoResistor Pin  int lightLevel = analogRead(lightPin); //Read the
int lightPin = 0; //the analog pin the                                         // lightlevel
                  //photoresistor is  lightLevel = map(lightLevel, 0, 900, 0, 255); 
                  //connected to          //adjust the value 0 to 900 to
                  //the photoresistor is not   lightLevel = constrain(lightLevel, 0, 255);
                  //calibrated to any units so       //make sure the value is betwween 0 and 255                                                   
                  //this is simply a raw sensor   analogWrite(ledPin, lightLevel);  //write the value

}value (relative light)
//LED Pin
int ledPin = 9;//the pin the LED is connected to
               //we are controlling brightness so 
               //we use one of the PWM (pulse 
               //width modulation pins)

void setup()
{
  pinMode(ledPin, OUTPUT); //sets the led pin to 
                           //output
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What We’re Doing:

.:Light:.

.:Photo Resistors:.

Whilst getting input from a potentiometer can be useful 

for human controlled experiments, what do we use 

when we want an environmentally controlled experiment? 

We use exactly the same principles but instead of a 

potentiometer (twist based resistance) we use a photo resistor (light based 

resistance). The Arduino cannot directly sense resistance (it senses voltage) so we 

set up a voltage divider ( http://tinyurl.com/2sunta ). The exact voltage at the 

sensing pin is calculable, but for our purposes (just sensing relative light) we can 

experiment with the values and see what works for us. A low value will occur when 

the sensor is well lit while a high value will occur when it is in darkness.

The Circuit:

Wire

  

Photo-Resistor

x1

560 Ohm Resistor
Green-Blue-Brown

x1

2 Pin Header

x4

CIRC-10 

Breadboard sheet

x1

.:download:.
printable 

breadboard overlay
http://tinyurl.com/cmzfdu

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/cdldd6

The Internet

Green LED

x1

10k Ohm Resistor
Brown-Black-Red

x1

Schematic:
Arduino 
pin 13

LED
(light 
emitting 
diode)

resistor 
(560ohm)

gnd
(ground) (-)

+5 volts

photo
resistor

resistor 
(10k ohm)

Arduino 
analog
pin 0

Parts:



Frustration?
Shoot us an e-mail, this circuit 

is both simple and complex at 

the same time. We want to 

hear about problems you have 

so we can address them in 

future editions.
 help@oomlout.com

It Isn't Responding to 

Changes in Light.

Given that the spacing of the 

wires on the photo-resistor is 

not standad, it is easy to 

misplace it. Double check its in 

the right place
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CIRC-09Code (no need to type everything in just)

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/cpa83c

Making it Better

LED is Remaining Dark

This is a mistake we continue 

to make time and time again, if 

only they could make an LED 

that worked both ways. Pull it 

up and give it a twist.

Reverse the response: Light controlled servo:
Perhaps you would like the opposite response. Don't Lets use our newly found light sensing skills to control a servo 

worry we can easily reverse this response just change. (and at the same time engage in a little bit of Arduino code 

 analogWrite(ledPin, lightLevel); ----> hacking). Wire up a servo connected to pin 9 (like in CIRC-04). 
analogWrite(ledPin, 255 - lightLevel); Then open the Knob example program (the same one we used 

Upload and watch the response change.
in CIRC-08) File > Sketchbook > Examples > Library-

Servo > Knob. Upload the code to your board and watch as it Night light:
Rather than controlling the brightness of the LED in works unmodified.

Using the full range of your servo:response to light, lets instead turn it on or off based on a 
You'll notice that the servo will only operate over a limited 

threshold value. Change the loop() code with.
  void loop(){ portion of its range. This is because with the voltage dividing 
     int threshold = 300;

circuit we use the voltage on analog pin 0 will not range from      if(analogRead(lightPin) > threshold){
       digitalWrite(ledPin, HIGH); 0 to 5 volts but instead between two lesser values (these 
     }else{
       digitalWrite(ledPin, LOW);    values will change based on your setup). To  fix this play with 
     }

the val = map(val, 0, 1023, 0, 179); line. For hints on what to }

do visit http://arduino.cc/en/Reference/Map .

Download the Code from ( http://tinyurl.com/crdum6 )
(copy the text and paste it into an empty Arduino Sketch)

/* }
 * A simple programme that will change the  /*
 * intensity of an LED based  on the amount of  * loop() - this function will start after setup 
 * light incident on the photo resistor.  * finishes and then repeat
 *  */
 */ void loop()

{
//PhotoResistor Pin  int lightLevel = analogRead(lightPin); //Read the
int lightPin = 0; //the analog pin the                                         // lightlevel
                  //photoresistor is  lightLevel = map(lightLevel, 0, 900, 0, 255); 
                  //connected to          //adjust the value 0 to 900 to
                  //the photoresistor is not   lightLevel = constrain(lightLevel, 0, 255);
                  //calibrated to any units so       //make sure the value is betwween 0 and 255                                                   
                  //this is simply a raw sensor   analogWrite(ledPin, lightLevel);  //write the value

}value (relative light)
//LED Pin
int ledPin = 9;//the pin the LED is connected to
               //we are controlling brightness so 
               //we use one of the PWM (pulse 
               //width modulation pins)

void setup()
{
  pinMode(ledPin, OUTPUT); //sets the led pin to 
                           //output
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What We’re Doing:

.:Light:.

.:Photo Resistors:.

Whilst getting input from a potentiometer can be useful 

for human controlled experiments, what do we use 

when we want an environmentally controlled experiment? 

We use exactly the same principles but instead of a 

potentiometer (twist based resistance) we use a photo resistor (light based 

resistance). The Arduino cannot directly sense resistance (it senses voltage) so we 

set up a voltage divider ( http://tinyurl.com/2sunta ). The exact voltage at the 

sensing pin is calculable, but for our purposes (just sensing relative light) we can 

experiment with the values and see what works for us. A low value will occur when 

the sensor is well lit while a high value will occur when it is in darkness.

The Circuit:

Wire

  

Photo-Resistor

x1

560 Ohm Resistor
Green-Blue-Brown

x1

2 Pin Header

x4

CIRC-10 

Breadboard sheet

x1

.:download:.
printable 

breadboard overlay
http://tinyurl.com/cmzfdu

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/cdldd6

The Internet
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Gibberish is Displayed

This happens because the serial 

monitor is receiving data at a 

different speed than expected. 

To fix this, click the pull-down 

box that reads "*** baud" and 

change it to "9600 baud".

27

CIRC-10Code (no need to type everything in just)

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/c89tvd

Making it Better

Nothing Seems to Happen

This program has no outward 

indication it is working. To see 

the results you must open the 

Arduino IDE's serial monitor.
(instructions on previous page)

Outputting voltage: this first revert to the original code then change:
 Serial.println(temperature); This is a simple matter of changing one line. Our sensor 

---->
 Serial.print(temperature); outputs 10mv per degree centigrade so to get voltage we 

Serial.println(" degrees centigrade");
simply display the result of getVoltage().

The change to the first line means when we next output it will 
delete the line   temperature = (temperature - .5) * 100;         

appear on the same line, then we add the informative text and 

Outputting degrees Fahrenheit: a new line.
Again this is a simple change requiring only math. to go Changing the serial speed:

If you ever wish to output a lot of data over the serial line time degrees C ----> degrees F we use the formula. 
( F = C * 1.8) +  32 )  is of the essence. We are currently transmitting at 9600 baud 

add the line  but much faster speeds are possible. To change this change 
temperature = 

(((temperature - .5) * 100)*1.8) + 32; the line:
  Serial.begin(9600); ----> Serial.begin(115200);before Serial.println(temperature);

Upload the sketch turn on the serial monitor, then change the 
More informative output: speed from 9600 baud to 115200 baud in the pull down menu. 
Lets add a message to the serial output to make what is 

You are now transmitting data 12 times faster.
appearing in the Serial Monitor more informative. To do 

Temperature Value is 

Unchanging/Wrong

This will happen if the LM35 is 

plugged in backwards. Look 

carefully at the layout sheet.

Download the Code from ( http://tinyurl.com/dfj8rs)
(copy the text and paste it into an empty Arduino Sketch)

/* --------------------------------------------- {
 * |  Arduino Experimentation Kit Example Code |  float temperature = 
 * |  CIRC-10 .: Temperature :.                | getVoltage(temperaturePin);  
 * ---------------------------------------------            //getting the voltage reading from the 
 *               //temperature sensor
 *  A simple program to output the current temperature 
 *  to the IDE's debug window  
 *  For more details on this circuit: 
 *  http://tinyurl.com/c89tvd  */ temperature = (temperature - .5) * 100;//converting from 10 mv

                       //per degree wit 500 mV offset to
//TMP36 Pin Variables                        //degrees ((volatge - 500mV) times 100)
int temperaturePin = 0;//the analog pin the TMP36's  Serial.println(temperature); //printing the result
                       //Vout pin is connected to  delay(1000);                 //waiting a second
                       //the resolution is }
                       //10 mV / degree centigrade                         
                       //(500 mV offset) to make /*
                       //negative temperatures an option  * getVoltage() - returns the voltage on the analog input 

 * defined by pin
void setup()  */
{ float getVoltage(int pin){
  Serial.begin(9600);  //Start the serial connection   return (analogRead(pin) * .004882814);//converting from a 0 
                       //with the copmuter                        //to 1024 digital range
                       //to view the result open the                        // to 0 to 5 volts 
                       //serial monitor                                               //(each 1 reading equals ~ 5 millivolts
                       //last button beneath the file }
                       //bar (looks like a box with an 
                       //antenae)
}
 
void loop()                     // run over and over 

again
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What We’re Doing:

.:Temperature:.
.:TMP36 Precision Temperature Sensor:.

What's the next phenomena we will measure with our Arduino? 

Temperature. To do this we'll use a rather complicated IC 

(integrated circuit) hidden in a package identical to our 2N222A 

transistors. It has three pins ground, signal and +5 volts, and is 

easy to use. It outputs 10 millivolts per degree centigrade on the signal 

pin (to allow measuring temperatures below freezing there is a 500 mV offset eg. 25  C = 750 mV, 

0  C = 500mV). To convert this from the digital value to degrees we will use some of the Arduino's 

maths abilities. Then to display it we'll use one of the IDE's rather powerful features, the debug 

window. We'll output the value over a serial connection to display on the screen. Let's get to it.

One extra note, this circuit uses the Arduino IDE's serial monitor. To open this, first upload the 

program then click the button which looks like a square with an antennae.

The TMP36 Ddatasheet:

http://tinyurl.com/plbx38

°

°

The Circuit:

Wire

TMP36

Temperature Sensor

x1

2 Pin Header

x4

CIRC-10

Breadboard sheet

x1

.:download:.
printable 

breadboard overlay
http://tinyurl.com/ctdjod

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/d85jyx

The Internet

Schematic:
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Parts:

the chip will have 
TMP36 printed on it
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different speed than expected. 

To fix this, click the pull-down 

box that reads "*** baud" and 

change it to "9600 baud".
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CIRC-10Code (no need to type everything in just)

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/c89tvd

Making it Better

Nothing Seems to Happen

This program has no outward 

indication it is working. To see 

the results you must open the 

Arduino IDE's serial monitor.
(instructions on previous page)

Outputting voltage: this first revert to the original code then change:
 Serial.println(temperature); This is a simple matter of changing one line. Our sensor 

---->
 Serial.print(temperature); outputs 10mv per degree centigrade so to get voltage we 

Serial.println(" degrees centigrade");
simply display the result of getVoltage().

The change to the first line means when we next output it will 
delete the line   temperature = (temperature - .5) * 100;         

appear on the same line, then we add the informative text and 

Outputting degrees Fahrenheit: a new line.
Again this is a simple change requiring only math. to go Changing the serial speed:

If you ever wish to output a lot of data over the serial line time degrees C ----> degrees F we use the formula. 
( F = C * 1.8) +  32 )  is of the essence. We are currently transmitting at 9600 baud 

add the line  but much faster speeds are possible. To change this change 
temperature = 

(((temperature - .5) * 100)*1.8) + 32; the line:
  Serial.begin(9600); ----> Serial.begin(115200);before Serial.println(temperature);

Upload the sketch turn on the serial monitor, then change the 
More informative output: speed from 9600 baud to 115200 baud in the pull down menu. 
Lets add a message to the serial output to make what is 

You are now transmitting data 12 times faster.
appearing in the Serial Monitor more informative. To do 

Temperature Value is 

Unchanging/Wrong

This will happen if the LM35 is 

plugged in backwards. Look 

carefully at the layout sheet.

Download the Code from ( http://tinyurl.com/dfj8rs)
(copy the text and paste it into an empty Arduino Sketch)

/* --------------------------------------------- {
 * |  Arduino Experimentation Kit Example Code |  float temperature = 
 * |  CIRC-10 .: Temperature :.                | getVoltage(temperaturePin);  
 * ---------------------------------------------            //getting the voltage reading from the 
 *               //temperature sensor
 *  A simple program to output the current temperature 
 *  to the IDE's debug window  
 *  For more details on this circuit: 
 *  http://tinyurl.com/c89tvd  */ temperature = (temperature - .5) * 100;//converting from 10 mv

                       //per degree wit 500 mV offset to
//TMP36 Pin Variables                        //degrees ((volatge - 500mV) times 100)
int temperaturePin = 0;//the analog pin the TMP36's  Serial.println(temperature); //printing the result
                       //Vout pin is connected to  delay(1000);                 //waiting a second
                       //the resolution is }
                       //10 mV / degree centigrade                         
                       //(500 mV offset) to make /*
                       //negative temperatures an option  * getVoltage() - returns the voltage on the analog input 

 * defined by pin
void setup()  */
{ float getVoltage(int pin){
  Serial.begin(9600);  //Start the serial connection   return (analogRead(pin) * .004882814);//converting from a 0 
                       //with the copmuter                        //to 1024 digital range
                       //to view the result open the                        // to 0 to 5 volts 
                       //serial monitor                                               //(each 1 reading equals ~ 5 millivolts
                       //last button beneath the file }
                       //bar (looks like a box with an 
                       //antenae)
}
 
void loop()                     // run over and over 

again
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What We’re Doing:

.:Temperature:.
.:TMP36 Precision Temperature Sensor:.

What's the next phenomena we will measure with our Arduino? 

Temperature. To do this we'll use a rather complicated IC 

(integrated circuit) hidden in a package identical to our 2N222A 

transistors. It has three pins ground, signal and +5 volts, and is 

easy to use. It outputs 10 millivolts per degree centigrade on the signal 

pin (to allow measuring temperatures below freezing there is a 500 mV offset eg. 25  C = 750 mV, 

0  C = 500mV). To convert this from the digital value to degrees we will use some of the Arduino's 

maths abilities. Then to display it we'll use one of the IDE's rather powerful features, the debug 

window. We'll output the value over a serial connection to display on the screen. Let's get to it.

One extra note, this circuit uses the Arduino IDE's serial monitor. To open this, first upload the 

program then click the button which looks like a square with an antennae.

The TMP36 Ddatasheet:

http://tinyurl.com/plbx38

°

°

The Circuit:
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.:download:.
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No Clicking Sound

The transistor or coil portion of 

the circuit isn't quite working. 

Check the transistor is plugged 

in the right way.
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CIRC-11Code (no need to type everything in just)

File > Sketchbook > Examples > Digital > Blink
(example from the great arduino.cc site check it out for other great ideas)

/*
 * Blink
 *
 * The basic Arduino example.  Turns on an LED on for one second,
 * then off for one second, and so on...  We use pin 13 because,
 * depending on your Arduino board, it has either a built-in LED
 * or a built-in resistor so that you need only an LED.
 *
 * http://www.arduino.cc/en/Tutorial/Blink
 */

int ledPin = 2;                // ***********  CHANGE TO PIN 2 ************

void setup()                    // run once, when the sketch starts
{
  pinMode(ledPin, OUTPUT);      // sets the digital pin as output
}

void loop()                     // run over and over again
{
  digitalWrite(ledPin, HIGH);   // sets the LED on
  delay(1000);                  // waits for a second
  digitalWrite(ledPin, LOW);    // sets the LED off
  delay(1000);                  // waits for a second
}

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/cfagqn

Making it Better

Not Quite Working

The included relays are 

designed to be soldered rather 

than used in a breadboard. As 

such you may need to press it 

in to ensure it works. (and it 

may pop out occasionally)

Controlling a Motor
In CIRC-03 we controlled a motor using a transistor. 

However if you want to control a larger motor a relay is a 

good option. To do this simply remove the red LED, and 

connect the motor in its place (remember to bypass the 

560 Ohm resistor)
Controlling Motor Direction
A bit of a complicated improvement to finish. To control 

the direction of spin of a DC motor we must be able to 

reverse the direction of current flow through it. To do this 

manually we reverse the leads. To do it electrically we 

require something called an h-bridge. It can be 

constructed using either four transistors (2 PNP and 2 

NPN) or using one DPDT relay. To control the motor's 

It looks complicated but can be accomplished using only direction, wire up the following circuit

a few extra wires. Give it a try.

Nothing Happens

The example code uses pin 13 

and we have the relay 

connected to pin 2. Make sure 

you made this change in the 

code.
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What We’re Doing:

.:Larger Loads:.

.:Relays:.

The final circuit is a bit of a test. We combine what we learned 

about using transistors in CIRC03 to control a relay. A relay is 

an electrically controlled mechanical switch. Inside the little 

plastic box is an electromagnet that, when energized, causes a 

switch to trip (often with a very satisfying clicking sound). You can buy relays that vary in size 

from a quarter of the size of the one in this kit up to as big as a fridge, each capable of 

switching a certain amount of current. They are immensely fun because there is an element of 

the physical to them. While all the silicon we've played with to this point is fun sometimes you 

just want to wire up a hundred switches to control something magnificent. Relays give you the 

ability to dream it up then control it with your Arduino. Now to using todays technology to 

control the past. (The 1N4001 diode is acting as a flyback diode for details on why its there visit: http://tinyurl.com/b559mx)

The Circuit:

2 Pin Header

x4

CIRC-11 

Breadboard sheet

x1

Schematic:

.:download:.
printable 

breadboard overlay
http://tinyurl.com/cxpvgq.

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/chf7rx

The Internet
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No Clicking Sound

The transistor or coil portion of 

the circuit isn't quite working. 

Check the transistor is plugged 

in the right way.
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CIRC-11Code (no need to type everything in just)

File > Sketchbook > Examples > Digital > Blink
(example from the great arduino.cc site check it out for other great ideas)

/*
 * Blink
 *
 * The basic Arduino example.  Turns on an LED on for one second,
 * then off for one second, and so on...  We use pin 13 because,
 * depending on your Arduino board, it has either a built-in LED
 * or a built-in resistor so that you need only an LED.
 *
 * http://www.arduino.cc/en/Tutorial/Blink
 */

int ledPin = 2;                // ***********  CHANGE TO PIN 2 ************

void setup()                    // run once, when the sketch starts
{
  pinMode(ledPin, OUTPUT);      // sets the digital pin as output
}

void loop()                     // run over and over again
{
  digitalWrite(ledPin, HIGH);   // sets the LED on
  delay(1000);                  // waits for a second
  digitalWrite(ledPin, LOW);    // sets the LED off
  delay(1000);                  // waits for a second
}

Not Working? (3 things to try)

More, More, More:
More details, where to buy more parts, where to ask more questions.

http://tinyurl.com/cfagqn

Making it Better

Not Quite Working

The included relays are 

designed to be soldered rather 

than used in a breadboard. As 

such you may need to press it 

in to ensure it works. (and it 

may pop out occasionally)

Controlling a Motor
In CIRC-03 we controlled a motor using a transistor. 

However if you want to control a larger motor a relay is a 

good option. To do this simply remove the red LED, and 

connect the motor in its place (remember to bypass the 

560 Ohm resistor)
Controlling Motor Direction
A bit of a complicated improvement to finish. To control 

the direction of spin of a DC motor we must be able to 

reverse the direction of current flow through it. To do this 

manually we reverse the leads. To do it electrically we 

require something called an h-bridge. It can be 

constructed using either four transistors (2 PNP and 2 

NPN) or using one DPDT relay. To control the motor's 

It looks complicated but can be accomplished using only direction, wire up the following circuit

a few extra wires. Give it a try.

Nothing Happens

The example code uses pin 13 

and we have the relay 

connected to pin 2. Make sure 

you made this change in the 

code.
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What We’re Doing:

.:Larger Loads:.

.:Relays:.

The final circuit is a bit of a test. We combine what we learned 

about using transistors in CIRC03 to control a relay. A relay is 

an electrically controlled mechanical switch. Inside the little 

plastic box is an electromagnet that, when energized, causes a 

switch to trip (often with a very satisfying clicking sound). You can buy relays that vary in size 

from a quarter of the size of the one in this kit up to as big as a fridge, each capable of 

switching a certain amount of current. They are immensely fun because there is an element of 

the physical to them. While all the silicon we've played with to this point is fun sometimes you 

just want to wire up a hundred switches to control something magnificent. Relays give you the 

ability to dream it up then control it with your Arduino. Now to using todays technology to 

control the past. (The 1N4001 diode is acting as a flyback diode for details on why its there visit: http://tinyurl.com/b559mx)

The Circuit:

2 Pin Header

x4

CIRC-11 

Breadboard sheet

x1

Schematic:

.:download:.
printable 

breadboard overlay
http://tinyurl.com/cxpvgq.

.:view:.
video of the circuit 
being assembled

http://tinyurl.com/chf7rx

The Internet
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